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Marksman Elite 

 

Раздел 1: Введение 
 

Marksman© Elite – улучшенный контроллер струйного принтера высокого разрешения, который 

работает на платформе Microsoft Windows XP®. На нем установлена клавишная панель с ЖК-экраном 

с сенсорным управлением. Marksman© Elite может управлять печатающими головками высокого 

разрешения серии Elite Series в количестве до шести для печати стандартизированных штрихкодов, 

изображений или буквенно-цифрового текста на пористых материалах и коробках. В настоящем 

руководстве описывается функционирование системы печати Marksman© Elite Ink Jet Printing System, 

контроллера Marksman © Elite Controller и печатающих головок. 
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Раздел 2: Меры предосторожности 

 

Далее приведен список условных обозначений мер предосторожности, встречающихся в данном 

руководстве, и их значение. Обращайте внимание на эти обозначения в настоящем руководстве. 

 

При выполнении описываемой процедуры пользуйтесь защитными очками! 

 

 

«Внимание» или «Осторожно»! Означает возможность получения травм и/или 

нанесения ущерба оборудованию. 

 

 

«Внимание» или «Осторожно»! Означает возможность получения травм и/или 

нанесения ущерба оборудованию вследствие поражения электрическим током. 

 

 

ПРИМЕЧАНИЕ: (Будет приведен короткий комментарий или пояснение.) 

 

  

 

Работать с данным оборудованием и заниматься его обслуживанием должен только 

специально обученный персонал. 

 

ПРИМЕЧАНИЕ: Очень важно выполнять следующие действия: 

 

• Незамедлительно удаляйте все утечки чернил с помощью соответствующих 

кондиционеров и утилизируйте все отходы в соответствии с местным и федеральным 

законодательством. 

• При работе с чернилами и кондиционерами пользуйтесь защитными очками и 

спецодеждой, в том числе перчатками. 

• Храните чернила и кондиционеры в соответствии с рекомендованными условиями 

хранения, приведенными в MSDS (Material Safety Data Sheet – Руководство по 

безопасному обращению с материалами). 

 

  

 

СВЕДЕНИЯ О СООТВЕТСТВИИ СТАНДАРТАМ: 

 

Настоящий продукт соответствует стандарту CAN/CSA-22.2 NO.60950-00 * UL 60950 при 

использовании компонентов, одобренных FoxJet (ITW Company). Тестирование и оценка 

качества производились исключительно с чернилами, компонентами и аксессуарами, 

одобренными FoxJet (ITW Company). Использование других чернил, компонентов или 

аксессуаров может привести к появлению возможных рисков, ответственности за 

которые компания FoxJet (ITW Company) не несет. 
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!Раздел 3: Компоненты системы 

 

 

1 Контроллер 

2 Печатающая головка ProSeries 

3 Конвейер 

4 Изделие 

5 Крепежный кронштейн системы 

печати 

6 Датчик скорости конвейера 

7 Резервуар с чернилами 

8 Фотодетектор 

9 Вакуумный резервуар сборника 

отходов 

10 Кабель датчика скорости 

конвейера 

11 Индикатор ошибки (строб) 
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Система Marksman© Ink Jet System доступна со следующими основными, дополнительными и 

сервисными компонентами: 

 

№ компонента Описание 

 

Встроенная печатающая головка 

 

2464034  ProSeries 384, встроенная с системой Автоматической очистки сопел, ScanTrue II® 

2464236  ProSeries 384, сборная 

2464025  ProSeries 768, встроенная с системой Автоматической очистки сопел, ScanTrue II® 

2464232  ProSeries 768, сборная, вертикальная, ScanTrue II® 

 

Сборка контроллера 

 

2465004D2  Блок контроллера, Marksman© Elite, 2 головки, местный рынок 

2465004E2  Блок контроллера, Marksman© Elite, 2 головки, европейский рынок 

2465246  Elite PHC Board Kit 

 

Крепление печатающей головки/контроллера 

 

2464550  Крепление печатающей головки на конвейер 

2464552  Крепление для печатающей головки 96/192 с возвратом 

2464553  Штифтовое крепление печатающей головки 

2464561  Регулировка по осям X-Y, крепление без вспомогательных компонентов 

2464562  Простое/вращающееся крепление на конвейер для печатающей головки 768 

2464563  Набор креплений для напольного крепления печатающей головки 

2464564  Простое/вращающееся крепление на конвейер для печатающей головки 384/352 

2464565  Крепление на конвейер с направляющими полозьями для печатающей головки 384/768 

2465201  Набор креплений контроллера T-Base 

2465219  Набор креплений конвейера контроллера 

 

Датчик скорости конвейера, фотодетектор, индикатор ошибки 

 

2465224  Фотодетектор ProSeries 

2465253  Индикатор ошибки (строб), трехцветный 

 

Кабели 

 

2464182-010  Кабель, прямой, DB9, 10 футов (3 м) 

2464182-025  Кабель, прямой, DB9, 25 футов (7.5 м) 

2464182-050  Кабель, прямой, DB9, 50 футов (15 м) 

2465155-010  Набор кабелей, печатающая головка, DB25, 10 футов (3 м) 

2465155-025  Набор кабелей, печатающая головка, DB25, 25 футов (7.5 м) 
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Встроенная печатающая головка 

 

РЕЗЕРВУАР 

ДЛЯ ЧЕРНИЛ 

РЕЗЕРВУАР 

ДЛЯ ОТХОДОВ 

СИСТЕМА ОБРАБОТКИ 

ЧЕРНИЛ 

ПЕЧАТАЮЩАЯ 

ГОЛОВКА 
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Крепежный кронштейн 
 

Крепежный кронштейн – это конструкция, которая удерживает контроллер, систему печати и другие 

компоненты. В настоящем руководстве описаны инструкции по установке всех компонентов системы 

на конвейер. Другие возможности установки контроллера и системы печати включают крепление на 

полу и крепление с возвратом. Инструкции по сборке входят в комплект поставки компонентов. 

 

 

Крепление 

конвейера 

Крепление с 

возвратом 

Крепление на 

полу 
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Фотодетектор 
 
Фотодетектор одновременно содержит и источник света, и датчик. Он испускает поток 

света и определяет появление изделия, когда оно отражает свет от источника обратно на 

датчик. Затем датчик отправляет сигнал о начале цикла печати контроллеру. 

 

Датчик скорости конвейера 
 
Датчик скорости конвейера передает 

контроллеру информацию о скорости 

конвейера. Он также позволяет 

автоматически отключить печать при 

остановке линии конвейера.  

 

Система Marksman© Elite System использует 

кодировщик с открытым коллектором 5000 

ppr. Размер колесика подобран так, чтобы 

сформировать верные временные интервалы 

для печати с разрешением от 150 до 300 dpi. 

 

 
 

 

Чернила 
 
Чернила поставляются в пластиковых контейнерах объемом 500 мл. Типы чернил 

включают VersaPrint ™ V300 на основе гликолевого масла для печати общего назначения 

и пигментированные чернила ScanTrue® II для печати краев с высоким разрешением. Оба 

типа чернил подходят для печати на пористых поверхностях. 
 

 

 

ПРИМЕЧАНИЕ: Для выбора верного типа чернил проверьте обозначения на 

печатающей головке. 
 

 

 

ПРИМЕЧАНИЕ: VersaPrint™ V300 и ScanTrue® II являются несмешиваемыми. НЕ 

СМЕШИВАЙТЕ чернила. 

  

  
Резервуар для сбора отходов 

 
Система автоматической заправки включает резервуар для сбора отходов, 

устанавливаемый на задней поверхности печатающей головки. Для правильного 

функционирования системы этот резервуар следует заменить, когда он заполнится. 

Инструкции по переработке отходов приведены на резервуаре. 

БЛОК ДАТЧИКА СКОРОСТИ 
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Раздел 4: Установка 

 
На рисунке ниже приведена обычная установка с креплением на конвейер. (Кабели не показаны.) 

 

 
 

Компоненты, необходимые для установки 
 

Вам потребуются следующие компоненты: 

 

• Неворсистая ткань 

• Защитные очки 

• Уровень (инструмент) 

• Измерительная лента (рулетка) 

 

Соблюдайте соответствующие процедуры и меры предосторожности. Не вынимайте печатающие 

головки из коробок, пока все крепления не установлены и не затянуты. 
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Установка системы 

 

 

ПРИМЕЧАНИЕ: Далее описывается процедура установки системы печати Marksman © 

Elite. За более подробной информацией обращайтесь в соответствующий раздел. 

1. Тщательно продумайте размещение оборудования. Ясно представляйте себе расположение 

крепежного кронштейна и размер принтера. 

2. Извлеките оборудование из упаковки. 

3. Соберите все крепления для напольной установки, установки на конвейере или другие крепления в 

соответствии с инструкциями, приведенными в разделе «Установка креплений». 

4. Установите и закрепите систему печати на соответствующих креплениях. Не подключайте ее к сети 

переменного тока. 

5. При использовании креплений с возвратом прикрепите дополнительное крепление с возвратом к 

каждой печатающей головке. 

6. Установите печатающую головку (головки) на соответствующий кронштейн и в соответствующее 

место согласно обозначениям на картонной коробке. 

7. Установите фотодетектор, дополнительные крепления и датчик скорости конвейера (если 

используется). 

 

 

ВНИМАНИЕ: Перед работой с печатающими головками снимите предохранительные 

крышки. 

 

Установка креплений 
 
В данном разделе описана установка креплений контроллера на конвейер. Это наиболее 

распространенный и самый надежный метод установки, так как все крепления прикрепляются 

болтами напрямую к конвейеру. 

 

Подробные инструкции по сборке входят в комплект компонентов сборки. 

 

Возможные варианты компонентов сборки с указанием номеров компонентов приведены в Разделе 3, 

Компоненты системы. 

 

Угловые крепления крепятся к алюминиевым планкам как показано ниже. 
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КРЕПЛЕНИЕ 

УГЛОВОГО 

КРЕПЛЕНИЯ 

Угловое крепление 

T-образная гайка 
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Установка системы печати 
 
Извлеките печатающую головку из упаковки непосредственно перед установкой на крепления. 

 

Установите печатающую головку на крепления с помощью монтажного крепления печатающей 

головки. 

 

Печатающая головка должна устанавливаться в непосредственной близости от изделия. Для 

обеспечения стойкого качества печати расстояние между печатающей головкой и поверхностью 

изделия должно составлять не более 1/8 дюйма (около 3.1 мм). Для крепления головки и управления 

расстоянием между печатающей головкой и поверхностью изделия предусмотрено дополнительное 

крепление с возвратом. Крепление с возвратом позволяет головке касаться поверхности изделия и 

возвращаться в исходное положение так, чтобы расстояние между печатающей головкой и 

поверхностью изделия оставалось постоянным. (Возможные варианты креплений можно найти в 

Разделе 3, Компоненты системы.) 

 

 

ПРИМЕЧАНИЕ: Установку дополнительного крепления с возвратом нужно производить 

до установки печатающей головки на крепление конвейера. 

 

Может потребоваться вертикальная регулировка горизонтальной планки каждого крепления для более 

точного расположения печатаемой строки. Это особенно актуально для нескольких печатающих 

головок, так как строки печатаемого текста нужно синхронизировать друг с другом. 

 

 

ПРИМЕЧАНИЕ: При регулировке положения горизонтальной планки или крепления 

печатающей головки всегда придерживайте печатающую головку рукой, чтобы она не 

упала на конвейер. 

 

 

ПРИМЕЧАНИЕ: Печатающие головки серии ProSeries работают с подачей чернил 

гравитационного и капиллярного типа внутрь печатающей головки. Чтобы избежать 

утечки чернил, положение печатающей головки по оси «передний край – задний край» 

должно быть строго горизонтальным. 
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Установка печатающей головки 
 
Печатающие головки серии Elite/Classic должны устанавливаться в отверстия с резьбой 10-32 на 

левой или правой стороне нижней части корпуса системы подачи чернил. Угол печатающей головки 

можно задать в диапазоне от 0° до 90°. 

 

Для установки необходимого угла: 

1. Ослабьте два установочных винта (с шестигранной головкой размером 1/8 дюйма) на креплении 

печатающей головки со стороны печатающей головки. 

2. Поверните головку на нужный угол. 

3. Заняните установочные винты. 

 

 
 

Установка фотодетектора 
 
Фотодетектор положения изделия можно установить на любой стороне печатающей головки в 

зависимости от направления печати. Выньте заглушки или выкрутите установочные винты (с 

шестигранной головкой размером 3/32" дюйма) из отверстий для крепления фотодетектора, затем 

установите крепление фотодетектора с помощью винтов 10-32 x ½ дюйма, поставляемых в комплекте 

с креплением. 

ПЕЧАТАЮЩАЯ 

ГОЛОВКА 

КРЕПЛЕНИЕ 

ПЕЧАТАЮЩЕЙ 

ГОЛОВКИ 

СИСТЕМА ПОДАЧИ ЧЕРНИЛ 

ОСЛАБЬТЕ 

УСТАНОВОЧНЫЕ 

ВИНТЫ ДЛЯ 

ПОВОРОТА 

ГОЛОВКИ 

НЕ ТРОГАЙТЕ ВИНТЫ СО 

СТОРОНЫ СИСТЕМЫ ПОДАЧИ 

ЧЕРНИЛ!!! 

ОТВЕРСТИЯ ДЛЯ 

УСТАНОВКИ 

ФОТОДЕТЕКТОРА ОТВЕРСТИЯ ДЛЯ 

УСТАНОВКИ 

ПЕЧАТАЮЩЕЙ 

ГОЛОВКИ 
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Предохранительные крышки 
 

 

ВНИМАНИЕ: Не работайте с печатающими головками системы автоматической 

заправки с закрытой предохранительной крышкой! Работа с закрытой крышкой может 

вызвать эффект сифона, который может привести к истощению источника чернил. 

 
Печатающие головки 384/768 

 

Ослабьте два винта с накатной головкой 

и снимите предохранительную крышку. 

(См. рисунок справа.) 

 
 

 

ПРИМЕЧАНИЕ: Если надеть предохранительную крышку на горячую печатающую 

головку и не затянуть винты, печатающая головка будет выделять чернила до тех пор, 

пока не охладится. 

 

 

ПРИМЕЧАНИЕ: В процессе транспортировки за предохранительной крышкой могут 

скапливаться чернила. 

 

ВИНТЫ 

ПРЕДОХРАНИТЕЛЬНАЯ КРЫШКА 
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Откройте крышку клапана резервуара 

и установите фильтр. Снимите 

предохранительную крышку 

резервуара и установите емкость с 

чернилами. Сохраните крышки для 

последующего использования. 

 

 

ВНИМАНИЕ: При 

вкручивании емкости с 

чернилами в резервуар 

не затягивайте ее 

слишком сильно. 

Перетягивание 

приведет к 

повреждению 

резервуара. 
 

 
  

Датчик скорости конвейера 
 
Датчик скорости конвейера 

использует колесико, которое 

вращается вместе с конвейерной 

линией для отслеживания скорости. 

Оно отправляет сигнал контроллеру, 

который выполняет при изменении 

скорости конвейера регулирует ее. 

 

Датчик не обязательно устанавливать 

рядом с печатающими головками. 

Важнее установить его там, где он 

сможет точно измерить скорость 

движения конвейера. Установите его 

так, чтобы он соприкасался с 

конвейером, колесом или валиком, 

вращающимся с той же скоростью, 

что и конвейер. 

 

Крепежный кронштейн датчика - 

пружинный. Отрегулируйте кольцо 

пружины так, чтобы датчик всегда 

оставался в надежном контакте с 

конвейером. 

 

  

 

ВНИМАНИЕ: Не допускайте того, чтобы колесо датчика сильно давило на конвейер. 

Радиальная сила более 40 фунтов приведет к снижению срока службы опор. 
 

ФИЛЬТР ЕМКОСТЬ С 

ЧЕРНИЛАМИ 

ПРЕДОХР. КРЫШКА 

РЕЗЕРВУАРА 

КРЫШКА  КЛАПАНА 

РЕЗЕРВУАРА 

КНОПКА 

ЗАПРАВКИ 

Конвейер 

Пружина 

К контроллеру 
Датчик 

Колесико 

датчика 

ДАТЧИК 

СКОРОСТИ 

КОНВЕЙЕРА 

Крепежный 

кронштейн 

Ось 

крепежного 

кронштейна 
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Подключение электрических кабелей 
 

 

СИСТЕМА 

ПЕЧАТИ 

СИСТЕМА 

ПЕЧАТИ 

ФОТОДЕТЕКТОР 

ДАТЧИК СКОРОСТИ 

КОНВЕЙЕРА 

ГЛАВНЫЙ КАБЕЛЬ ПРИНТЕРА 

КОНТРОЛЛЕР MARKSMAN ELITE ИНДИКАТОР 

ОШИБКИ 

(СТРОБ) 
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Виды 

 
 

 

КОНТРОЛЛЕР, ВИД СЗАДИ 

СИСТЕМА ПЕЧАТИ, ВИД СЗАДИ 

СТРОБ ДАТЧИК СКОР. 
ВЫХОДЫ НА ПЕЧ. 

ГОЛОВКИ. 

П
Л

А
ТЫ

 П
ЕЧ

. Г
О

Л
О

В
О

К
 

Л
И

Н
. В

Ы
Х

. 

ФОТОЭЛЕМЕНТ ВХОД С 

КОНТРОЛЛЕРА 
ПОВОРОТ ПЕЧ. 

ГОЛОВКИ 

ПИТАНИЕ ОТ 

КОНТРОЛЛЕРА 

СЛИВ 
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Заправка печатающих головок 
 

 

ПРИМЕЧАНИЕ: При появлении сигнала «недостаточно чернил» система не будет 

заправлена вручную или автоматически. Сигнал «недостаточно чернил» вызывается либо 

недостатком чернил в резервуаре с чернилами, либо заполнением резервуара для сбора 

отходов. 

 

Ручная заправка 
 

 

ПРИМЕЧАНИЕ: Для сбора лишних чернил воспользуйтесь салфеткой. 

 
Для выполнения ручной заправки отожмите кнопку на задней поверхности корпуса системы подачи 

чернил. Затем нажмите и удерживайте кнопку в течение одной секунды. Это запустит насос для 

ручной заправки. Он будет продолжать работать до тех пор, пока кнопка отжата, но не более пяти 

секунд. Если нужна дополнительная заправка, отпустите и нажмите кнопку снова. 

 

Короткое нажатие кнопки (менее 0.5 с) запустит цикл обслуживания. Если цикл обслуживания 

начался, то при нажатии кнопки ручная заправка не выполняется. (Заправка и вакуумный цикл 

продолжаются не более 10 с.) 

 

Цикл Автоматической системы очистки сопел 
 
Автоматическая система очистки сопел позволяет перезаправлять каналы в печатающей головке, если 

в некоторых из них отсутствуют чернила. Для этого в системе автоматической очистки сопел  

используются заправочный насос, который заправляет чернила в каналы, и вакуумный насос и 

резервуар для сбора отходов, в котором собираются использованные чернила. Для запуска цикла 

Автоматическая система очистки сопел быстро нажмите кнопку прочистить. 

 

 

ПРИМЕЧАНИЕ: Во время цикла Автоматическая система очистки сопел или ручной 

система очистки сопел печать может быть приостановлена. 

 



www.foxjet.ru     +7 (495) 984-0-489 Страница 23 
 

 

Управление системой автоматической очистки сопел 
 
Для управления циклом работы Автоматическая система очистки сопел  пользователем задается 

временной интервал заправки печатающей головки (если используется несколько печатающих 

головок, интервал заправки задается для каждой из них). Можно задать любой необходимый интервал 

промывки от двух до восемнадцати часов для печатающих головок UJII и от часа до двенадцати часов 

для графических печатающих головок. Значение по умолчанию для каждого типа головок – 4 часа 

(положение переключателя «2» для головок UJII и «C» для графических печатающих головок). Для 

изменения интервала используется поворотный переключатель (программируемый таймер), 

установленный на плате контроллера системы автоматической очистки (см. рисунок ниже). 

 

Значения интервала заправки для каждого положения переключателя (программируемого таймера) 

приведены в таблице. 

 

0 = без 

Автоматическая 

система очистки 

сопел 

Печатающие головки UJII Графические головки 

Положение 

переключателя 

0 1 2 3 4 5 6 7 8 9 A B C D E F 

Интервал 

(часы) 

0 2 4 6 8 10 12 14 16 18 1 2 4 6 8 12 

 

Настройка интервала очистки 

 

Очистка состоит из трех отдельных последовательных заправок длительностью около четырех 

миллисекунд каждая. Время, необходимое на очистку – не более пяти секунд, еще 20 секунд 

составляет цикл работы вакуумного насоса. Для печатающих головок Trident печать во время очистки 

невозможна. 
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ВЫНЬТЕ ЗАГЛУШКУ 

ДЛЯ ДОСТУПА К 

ПЕРЕКЛЮЧАТЕЛЮ 

ПОВОРОТНЫЙ 

ПЕРЕКЛЮЧАТЕЛЬ 

ЗНАЧЕНИЕ ПО 

УМОЛЧАНИЮ 

 – 2 (4 ЧАСА) 

СВЕТОДИОД 

САЗ для печатающих головок 
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Дополнительный фотоэлемент 
 

 

ПРИМЕЧАНИЕ: Кабель управления Автоматической системы очистки сопел и 

дополнительный фотоэлемент нельзя использовать одновременно. 

 
Для того, чтобы во время автоматической очистки сопел цикл печати не был прерван, можно 

воспользоваться входом «Дополнительный фотоэлемент». При подключении дополнительного 

фотоэлемента цикл заправки будет задержан до тех пор, пока не будет достаточно времени, чтобы 

выполнить заправку без пропуска цикла печати. Значение задержки по умолчанию – три (3) секунды с 

того момента, как изделие прошло рядом с фотоэлементом. Для совместной работы нескольких 

печатающих головок с дополнительным фотоэлементом можно воспользоваться кабелем 

фотоэлемента "Y". Чтобы изменить значение задержки по умолчанию, выполните следующие 

действия: 

1. Убедитесь, что поворотный переключатель не находится в положении «0». 

2. Поместите коробку перед фотоэлементом. 

3. Когда фотоэлемент сработает, переведите повортный переключатель в положение «0». 

4. Когда светодиод начнет гореть непрерывно, переведите поворотный переключатель в новое 

положение (от 1 до F), соответствующее числу секунд (от 1 до 15) в интервале задержки. 

Примечание: значение «0» задавать нельзя. 

5. Нажмите и удерживайте кнопку заправки, пока светодиод не начнет мигать. 

6. Отпустите кнопку заправки. 

7. Уберите коробку от фотоэлемента. 

8. Верните поворотный переключатель в предыдущее положение, соответствующее интервалу работы 

Автоматическая система очистки сопел. 
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Раздел 5: Начало работы 

 
Принтер Marksman© Elite – автономное устройство, которое может работать с печатающими 

головками Marksman© Elite в количестве от одной до четырех. Главное диалоговое окно программы 

управление принтером показано на рисунке: 

 

 
 
Для входа в систему кликните на иконке "Unlock" (Разблокировать) и введите имя пользователя и 

пароль. (Примечание: имена пользователей и пароли 

нечувствительны к регистру.) 

Имя пользователя: ADMIN 

Пароль: FOXJET 

 

В дереве меню справа показаны все пункты меню и все подменю 

программы управления принтером. 

 

Пункты меню являются настраиваемыми и могут быть недоступны 

для пользователей с ограниченным доступом. Для доступа ко всем 

пунктам меню у пользователя должны быть привилегии 

администратора. 

 

Для быстрого доступа к пунктам меню Start (Пуск), Stop (Останов), 

Idle (Бездействие), Resume (Возобновить работу), Edit 

(Редактировать), Logout (Выйти из системы) и Login (Войти в 

систему) также можно воспользоваться панелью инструментов. 

 

Скорость конвейера (Line Speed): Скорость конвейера – расстояние, 

проходимое конвейером, в футах в минуту. 

 

Конвейер (Production Line): Для выбора и отображения 
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используемого конвейера используется ряд кнопок над таблицей. С помощью настройки конвейера 

можно группировать печатающие головки. Можно создать и настроить до двух конвейеров. 

 

Панель (Panel): Название панели означает 

заданную грань прямоугольного 

параллелепипеда, представляющего изделие. 

С помощью каждой из шести панелей можно 

описать физическое расположение 

печатающей головки по отношению к 

изделию. 

 

Головка (Head): Название печатающей 

головки – заданное пользователем буквенно-

цифровое имя, связанное с физической 

печатающей головкой. Можно определить до 

шести печатающих головок. Каждая головка 

в системе должна иметь уникальное 

название. 

 

Задание (Task): Задание для одной из шести панелей, которые печатаются одновременно. 

 

Количество (Count): Значение в этом стоблце показывает, сколько раз было выполнено задание. 

 

Состояние изображения (Image State): Текущее состояние изображения для задачи. Возможные 

состояния – обрабатывается (Running), приостановлено (Paused), бездействие (Idle) и остановлено 

(Stopped). 

 

Состояние печатающей головки (Status Message): В данном столбце отображается состояние 

печатающей головки. 

Возможные состония: 

«Зеленый» 

OK – ошибок нет 

«Желтый» 

Ink Low (низкий уровень чернил) – необходимо заменить резервуар с чернилами 

«Красный» – Печать остановлена 

Ink Out (чернила отсутствуют) – В резервуаре печатающей головки закончились 

чернила. Замените резервуар с чернилами. 

Voltage Error (ошибка напряжения) – Контроллер не обнаруживает на печатающей 

головке достаточно высокого напряжения. 

Low Temp (низкая температура) – Температура печатающей головки находится вне 

рабочего диапазона температур. 

 

 

ПРИМЕЧАНИЕ: При ошибках «Ошибка напряжения», «Чернила отсутствуют» и 

«Низкая температура» печать производиться не будет. Если к системе подключен 

источник света, он будет мигать красным светом. 

 

Состояние системы (Status Line): В строке состояния системы отображаются прочие системные 

сообщения и состояние системы. Также отображается имя пользователя, вошедшего в систему. 

Верх (top) 

Низ (bottom) 

Правая грань 

(right) 

Левая грань 

(left) 

Передняя грань 

(front) / задняя 

грань (back) 
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Раздел 6: BoxWriter© Elite 

 

Настройка 

 

Настройка конвейера 
 
Настройка конвейера позволяет группировать 

настройки, которые относятся к конкретной 

конфигурации. Выберите Configure (Настройка), 

затем Production Line (Конвейер). Чтобы 

изменить строку, выберите ее и нажмите Edit 

(Редактировать) или дважды кликните на ней. 

 

Добавить (Add): Кнопка Add (Добавить) 

позволяет добавить новый конвейер, 

максимальное количество конвейеров равно 

двум. 

 

Удалить (Delete): Кнопка Delete (Удалить) 

позволяет удалить конвейер из настроек. Все сообщения/задачи этого конвейера будут удалены. 

 

Описание (Description): В этом поле можно задать описание конвейера. 

 

Связать (Coupled): Если эта галочка выбрана, при запуске задания на одном конвейере оно также 

будет запущено на другом. То же самое справедливо для остановки (Stop), бездействия (Idle) и 

возобновления работы (Resume). Чтобы эта возможность была доступна, необходимо задать 

настройки для двух конвейеров. 

 

Стационарный сканер 
 

В этой группе настроек задаются параметры 

стационарного сканера, который можно подключить к 

хабу Marksman©. Данные сохраняются в отчете 

сканирования (см. Просмотр отчета сканирования 

далее в этом разделе). 

 

Строка «Нет считывания» (No Read String): Значение 

строки «Нет считывания» должно соответствовать этой 

строке, передаваемой со стационарного сканера. 

 

Количество неудачных считываний (Consecutive No 

Reads): Это поле используется для проверки качества 

печатаемых штрихкодов. Его значение определяет 

максимальное количество неудачных считываний 

стационарного сканера. При достижении максимального значения печать будет остановлена. 
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Порт последовательной загрузки (Serial Download Port): Выберите порт, который будет 

использоваться для отправки данных на устройство в начале каждого задания. Данные вводятся в 

свойствах Редактора задания (Editor Task). 

 

Сброс в начале задания (Reset on Task Start): Галочка «Сброс в начале задания» определяет, будет ли 

текущее количество неудачных считываний будет сброшено в ноль в начале выполнения задания. 

 

Для сканирования необходимо войти в систему (Scan & Shoot requires login): Требует обязательного 

входа в систему перед тем, как с помощью портативного сканера можно будет выбрать новое задание. 

 

Портативный сканер 
 

Эта группа настроек определяет параметры обработки потока данных, передаваемого ручным 

сканером. Чтобы задание можно было запустить, данные, передаваемые портативным сканером, 

должны содержать ее корректное название. 

 

Смещение буфера (Buffer Offset): Смещение буфера задает смещение буфера в данных, передаваемых 

портативным сканером. 

 

Длина данных (Data Length): Это поле определяет количество символов, которые нужно извлечь из 

буфера данных чтобы получить название задания. 

 

Настройка печатающих головок 
 

Выберите Configure (Настройка), затем Print Heads 

(Печатающие головки). Выберите панель и кликните на 

головке. Для добавления/удаления головки нажмите 

соответствующую кнопку Add (Добавить)/Remove 

(Удалить). Для изменения параметров головки выберите ее 

и нажмите Edit (Редактировать) или дважды кликните на 

ней. 
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Название (Name): Имя печатающей головки, заданное 

пользователем. 

 

Панель (Panel): Панель, на которой будет печатать 

головка. 

 

Разрешение датчика (Encoder Resolution): Можно 

установить в 426dpi или 300dpi. Пожалуйста, 

проверьте разрешение используемого колесика 

датчика. 

 

ПРИМЕЧАНИЕ: Значение по умолчанию – 300dpi. 

 

Разрешение печати (Print Resolution): 150, 200 и 300 

точек на дюйм. 

 

Тип (Type): Выберите тип головки из выпадающего 

списка. 

 

Угол (Angle): Выберите угол положения головки по 

отношению к конвейеру. Для каждого типа головки 

доступно несколько углов поворота. 

 

Ширина печати (Print height): Ширина печати – максимальное покрытие одной печатающей головки 

для выбранного угла. 

 

Главная (Master): У каждой строки печати должна быть главная головка. Главная печатающая головка 

получает/передает сигналы фотоэлемента и датчика скорости на оставшиеся головки. 

 

Адрес (Address): С каждой картой связано две головки: 1a и 1b и 2a и 2b. У карт есть перемычки, 

определяющие, какая это карта. Нижний разъем карты всегда помечен как «a». 

 

Фотозадержка (Photo delay): Фотозадержка – горизонтальное расстояние (в дюймах) от фотоэлемента 

до печатающей головки. 

 

Автоматическая печать, дюймы (Auto print inches): Если выбран внутренний фотоэлемен, это число 

означает длину печатаемого сообщения. Например, если оно установлено в 36, внутренний 

фотоэлемент будет срабатывать раз в каждые 36 дюймов перемещения конвейера, фиксируемые 

датчиком скорости. 

 

Высота коробки (Height on box): Вертикальное расстояние в дюймах от нижней части изделия или 

конвейера до сопла печатающей головки. 

 

Скорость датчика (Encoder Speed): Заданная внутренняя скорость датчика в футах в минуту. Значение 

по умолчанию – 60 футов/мин. 
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Источник фотоэлемента (Photocell source): Показывает, является ли фотоэлемент внешним или 

внутренним. Также можно использовать (совместно) сигнал от любой другой головки. [См. 

Руководство по настройке общего доступа ниже.] 

 

Совместное использование фотоэлемента от ... (Sharing from): Совместное использование одного 

фотоэлемента и/или датчика несколькими головками. 

 

Источник датчика (Encoder source): Показывает, является ли датчик внешним или внутренним. Также 

можно использовать (совместно) сигнал от любой другой головки. [См. Руководство по настройке 

общего доступа ниже.] 

 

Направление (Direction): Направление движения продукта может быть «справа налево» (right-to-left) 

или «слева направо» (left-to-right), если смотреть из-за печатающей головки. 

 

Режим ожидания (Standby): Эта опция доступна только с печатающей головкой типа NP 192. Если 

печатающая головка не печатает в течение заданного количества часов, система перейдет в режим 

ожидания. В режиме ожидание температура головки и резервуара снизится, и система перейдет в 

режим бездействия. Чтобы вывести систему из режима ожидания просто запустите задание. 

 

Двойной импульс (Double Pulse): При выборе этой настройки печать становится более темной, 

обычно это необходимо для печатающих головк серий ProSeries 768 и 384. 

 

Активировано (Enable): Активирует карту и выдачу сообщений об ошибках. 

 

Инвертировать (Invert): Используется с устаревшими печатающими головками. 

 

Вверх ногами (Upside down): Используется для переворота всего изображения вверх ногами. 

 

Дополнительно: 
 

Связать с ... (Linked to): Связывает печатаемую информацию с 

дополнительными головками. Если информация на нескольких 

гранях коробки одинакова, головки связываются вместе и 

изображение автоматически назначается на другую головку. 

 

Системные параметры штрихкодов 
 

См Раздел 7: Редактор BoxWriter, Параметры штрихкодов. 
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Системные коды даты/времени 
 

См Раздел 7: Редактор BoxWriter, Коды даты/времени. 

 

Системные коды смены 
 

См Раздел 7: Редактор BoxWriter, Коды смены. 

 

Общие настройки 
 

Используются для настройки COM-порта 

системы. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Последовательный порт (Serial Port): Нажмите 

соответствующую кнопку для установки параметров 

последовательного порта хаба Marksman ©. 

Доступные свойства последовательных портов 

показаны в окне «Настройки последовательного 

порта» (Serial Settings). 

 

Значение каждого свойства можно выбрать их 

выпадающего списка. Когда все параметры 

выбраны, нажмите Apply (Применить). Значения по 

умолчанию показаны на рисунке справа. 

 

Бод (Baud): Скорость передаваемых данных (бит/с). 

Возможные значения – 9600, 19200, 38400, 57600 и 

115200. 

 

Четность (Parity): Тип используемого бита четности. 

Может быть установлено в None (без бита четности), 

Odd (нечетный) или Even (четный). 

 

Биты данных (Data Bits): Число используемых битов 

данных. Может быть установлено в 7 или 8. 

 

Стоповые биты (Stop Bits): Количество используемых стоповых битов: 1, 1.5 или 2. 
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Тип устройства (Device Type): Выберите, для чего 

будет использоваться последовательный порт: 

 

Запуск задания (Task Start) – 

Последовательное устройство используется 

для выбора/запуска задания, обычно с 

портативного сканера. 

 

Проверка штрихкода (Barcode Verification) – 

После печати каждого штрихкода его 

считывает стационарный сканер. 

 

Различные данные (Variable Data): через 

последовательный порт передаются 

печатаемые данные. 

 

Интерфейс хоста (Host Interface): Удаленное 

управление Elite через последовательный 

порт. 

 

Использует линию (Line Usage): Связывает линию с 

последовательным портом. 

 

 

 

 

 

Запуск: 
 

Для того, чтобы последнее задание, прерванное из-за 

отключения питания или выключения системы, 

перезапустилось автоматически, выберите галочку 

«Автоматически перезапускать последнее задание» 

(Automatically restart last task). (Она выбрана по 

умолчанию.) 
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Безопасность 

 

Управление пользователями 
 
Система безопасности Marksman© Elite Series позволяет 

администратору системы управлять пользователями и их правами 

доступа. 

 

Добавить (Add): Нажмите на кнопку Add (Добавить) чтобы создать 

нового пользователя. 

 

Удалить (Remove): Нажмите на кнопку Remove (Удалить) чтобы 

удалить пользователя. 

 

Свойства (Properties): Нажмите на кнопку Properties (Свойства) для 

просмотра или изменения информации о пользователе. 

 

Имя (Firstname): Введите в это поле имя пользователя. 

 

Фамилия (Lastname): Введите в это поле фамилию 

пользователя. 

 

Имя пользователя (Username): Введите в это поле 

уникальное имя пользователя. 

 

Пароль (Password): Введите в это поле уникальный 

буквенно-цифровой пароль. 

 

Повторите пароль (ReEnter Password): Повторно введите пароль для подтверждения. 

 

Уровень доступа (Security Group): Выберите уровень доступа, соответствующий необходимым правам 

пользователя. Свойства уровней доступа и уровень доступа пользователя можно изменить позднее. 

 

Нажмите OK для сохранения настроек и закрытия окна с информацией о пользователе. 

 

Параметры групп 
 
Уровни доступа позволяеют администратору 

назначать похожим пользователям заданный набор 

прав доступа. Выберите Безопасность (Security), а 

затем Параметры групп (Group Options) из меню. 

 

Доступно десять настраиваемых уровней. 

Пользователю может быть назначен только один 

уровень доступа. Имена уровней можно изменять, 

так чтобы они лучше описывали права доступа. 

Выберите уровень (Group), а затем отметьте 

галочками нужные права доступа (Options). Нажмите 

на кнопку Close (Закрыть), чтобы сохранить 

изменения и закрыть окно. 
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Права доступа по умолчанию для каждого уровня доступа показаны в следующей таблице: 

 

Уровень доступа/права доступа 
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Изменение настроек печатающих головок  X X  X X    X 

Запуск задания на печать X  X       X 

Остановка задания на печать X  X X X     X 

Печать тестового шаблона          X 

Запуск редактора          X 

Настройка конвейеров   X X  X    X 

Настройка пользователей          X 

Настройка параметров групп          X 

Коммуникационные настройки системы          X 

Просмотр отчета принтера          X 

Просмотр отчета сканера          X 

Настройка кодов даты/времени          X 

Определение глобальных переменных 

штрихкодов 

         X 

Определение кодов смены          X 

Выход из приложения          X 

Включение/отключение режима просмотра          X 

Обновление просмотра          X 

Настройка таблицы динамических данных          X 

Настройка общих параметров окон          X 

Перевод программы          X 

Настройка выходной таблицы          X 

Запуск базы данных          X 

Изменение информации о пользователе          X 

Изменение значения счетчика          X 

Настройка задания запуска базы данных          X 
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Вход в систему 
 

Каждый пользователь должен войти в приложение Marksman© Elite. Для этого можно 

воспользоваться пунктом меню, открытым замком на панели инструментов или 

комбинацией клавиш Ctrl+L. 

 

Имя пользователя (User Name): Введите имя 

пользователя, назначенное системным 

администратором. Имя пользователя не 

чувствительно к регистру. 

 

Пароль (Password): Введите пароль, 

назначенный системным администратором. 

Пароль не чувствителен к регистру. 

 

Нажмите кнопку OK для входа в систему. 

 

Выход из системы 
 

Для обеспечения безопасности после завершения работы каждый пользователь должен 

выйти из приложения Marksman© Elite. Для этого можно выбрать пункт меню Security > 

Logout (Безопасность > Выход из системы) или воспользоваться закрытым замком на 

панели инструментов. Система продожит работу в текущем состоянии. После выхода из системы все 

пункты меню за исключением Login (Вход в систему), About (О программе) и View Diagnostics 

(Просмотр диагностической информации) становятся недоступными. 

 
Справка 

 

Выбор языка 
 
Для переключения языка программы выберите пункт меню 

Help, Translate (Справка, Выбрать язык). Когда все файлы 

будут переведены на нужный язык, приложение будет 

перезапущено на этом языке. 
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Работа с программой 

 

Запуск задания 
 

Функция запуска задания используется для подготовки системы к 

печати текста или изображения, созданного в редакторе 

BoxWriter© Editor. 

 

Выберите пункт меню Operate > Start (Действия > Запуск). Выберите 

необходимую задачу из списка или введите ее имя и нажмите OK. 

 

Для запуска задания также можно выбрать соответствующую иконку на 

панели инструментов или воспользоваться комбинацией клавиш Ctrl+S. 

 

Сброс счетчика в ноль (Reset Count to zero): Эта кнопка позволяет 

накапливать значение счетчика при необходимости или сбрасывать его с 

началом каждого задания. 

 

Остановка задания 
 

При остановке задания будет остановлена вся печать для заданного конвейера. Счетчик 

изделий будет сброшен в ноль. 

 

Выберите соответствующий конвейер с помощью вкладок, затем выберите пункт меню Operate > 

Stop (Действия > Остановка) для остановки печати. 

 

Для остановки задания на выбранном конвейере также можно выбрать соответствующую иконку на 

панели инструментов, а для остановки печати задания – воспользоваться комбинацией клавиш 

Ctrl+End. 

 

Запуск задания из базы данных 
 

Создать задание на основе данных, размещенных в базе данных. Для того, чтобы эта иконка 

стала доступной, сначала нужно настроить базу данных. См. Приложение F: Запуск базы 

данных. 

 

Приостановка задания 
 

Приостановка задания приостанавливает выполнение задания для заданного конвейера. 

Счетчики изделий «замораживаются» до тех пор, пока печать не будет возобновлена. 

 

Для приостановки печати выберите пункт меню Operate > Idle (Действия > Приостановка). 

 

Для вызова функции приостановки задания также можно выбрать соответствующую иконку на 

панели инструментов, а для приостановки выполняющегося задания – воспользоваться комбинацией 

клавиш Ctrl+I. 
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Возобновление задания 
 

При возобновлении задания печать на заданном конвейере возобновляется. Значения 

счетчиков изделий восстанавливаются из ранее приостановленного задания. 

 

Для возобновления задания выберите пункт меню Operate > Resume (Действия > Возобновление). 

 

Для вызова функции возобновления задания также можно выбрать соответствующую иконку на 

панели инструментов, а для возобновления задания – воспользоваться комбинацией клавиш Ctrl+R. 

 

Изменение задания 
 

При выборе пункта меню «Изменение задания» запускается редактор Marksman© 

BoxWriter© Editor. Для работы с редактором у пользователя должны быть необходимые 

права. 

 

Для запуска редактора также можно выбрать соответствующую иконку на панели инструментов или 

воспользоваться комбинацией клавиш Ctrl+E. 

 

Дополнительная документация приведена в разделе «Редактор BoxWriter©» руководства. 

 

Тестовый шаблон 
 

Эта функция используется для проверки каждого канала печатающей головки чтобы 

удостовериться, что все они работают правильно. 

 

Когда пользователь нажимает на кнопку «Тестовый шаблон», генерируется тестовое 

изображение. Каждая головка выбранного конвейера напечатает это изображение (вместе с названием 

головки). На рисунке показан пример тестового изображения с головки 1. 
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Изменение пользовательских элементов 
 

Пользовательские элементы можно изменить только в том 

случае, если задание загружено. Для изменения 

пользовательских элементов задание должно их содержать 

и находиться в состоянии «Запущено» или 

«Приостановлено». 

 

Выберите пользовательский элемент из списка. Измените 

данные в поле внизу и нажмите OK для сохранения 

изменений. Для нескольких элементов сначала измените все 

необходимые данные, а затем нажмите OK. Для выхода без 

сохранения изменений нажмите Cancel. 

 

Для вызова окна пользовательских элементов можно нажать 

F2. 

 

Изменение значения счетчика 
 

Счетчик (Count) содержит текущий номер коробки в серии. Он 

всегда фигурирует как «последняя напечатанная» коробка 

("last printed"). Чтобы изменить значение счетчика (Count), 

введите текущее значение счетчика. Введите 0, чтобы на 

следующей коробке было напечатан номер 1. 

 

Выход из программы 
 

Пользователь может закрыть программу управления 

принтером Marksman© Elite Series, если у него есть 

соответствующий уровень доступа. При обычных 

обстоятельствах нет необходимости закрывать программу. 
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Просмотр 

 

Просмотр отчета о печати 
 

Отчет о печати содержит статистическую информацию об операциях печати. Отчет о печати – 

таблица reports в базе данных Microsoft® Access® Database с именем Marksman-Net. Выберите меню 

View (Просмотр), затем Printer Report (Отчет принтера). 

 

Время (Time): Дата и время возникновения события. 

 

Действие (Action): Действие означает событие, такое как запуск (Start) или остановка задания (Stop 

Task). 

 

Пользователь (User): Имя пользователя, который был в системе, когда произошло событие. 

 

Конвейер (Line): Конвейер, на котором произошло событие. 

 

Название задания (Taskname): Название задания, для которого произошло событие. 

 

Счетчик (Counts): Счетчик изделий задания, для которого произошло событие. 

 

Экспорт (Export): Позволяет экспортировать всю информацию в формате текста, разделенного 

запятыми, чтобы ей можно было воспользоваться в других приложениях. 

 

Автоматический экспорт при запуске задания (Auto Export at Task Start): Экспортирует задание в 

текстовый файл, расположение которого определяется путем экспорта. 

 

Пример отчета о печати приведен ниже: 

 

 
 

Для удаления всех записей из отчета нажмите Clear (Очистить).
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Просмотр отчета о сканировании 
 

Отчет о сканировании содержит информацию о текущей задаче и результаты сканирования 

напечатанного штрихкода. Результаты сканирования поступают по порту RS232 от должным образом 

настроенного и подключенного к контроллеру Marksman© Net сканера штрихкодов. 

 

 

ПРИМЕЧАНИЕ: Для подключения сканера к контроллеру Marksman© Elite необходим 

хаб Marksman©. 

Выберите меню View (Просмотр), затем Scan Report (Отчет сканера). 

 

Дата (Date): Дата возникновения события. 

 

Конвейер (Line): Конвейер, на котором произошло событие. 

 

Название задания (Taskname): Название задания, для которого произошло событие. 

 

Штрихкод (Barcode): Полученный и отсканированный штрихкод. Если код не удалось распознать, в 

этом поле будет показано сообщение «NO READ». 

 

Итого (Total): Общее количество попыток распознавания включая успешные и неудачные. 

 

Удачно (Good): Число удачных попыток распознавания штрихкода. 

 

Экспорт (Export): Позволяет экспортировать всю информацию в формате текста, разделенного 

запятыми, чтобы ей можно было воспользоваться в других приложениях. 

 

Автоматический экспорт при запуске задания (Auto Export at Task Start): Экспортирует задание в 

текстовый файл, расположение которого определяется путем экспорта. 

 

Пример отчета о сканировании приведен ниже: 

 

 
 

Для удаления всех записей из отчета нажмите Clear (Очистить). 
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Диагностика 

 

Диалоговое окно «Диагностика» 

предназначено для отладки и проверки 

потока данных, поступающих от 

внешнего последовательного 

устройства. 

 

Чаще всего проверяют, что данные от 

устройства получены и их формат 

корректен. 

 

Чтобы очистить содержимое окна, 

нажмите Clear (Очистить). 

 

Предварительный просмотр 
 

Эта возможность может быть отключена для некоторых применений, когда задачи переключаются 

очень быстро. 

 

Обновление 
 

Выберите головку и нажмите Refresh (Обновить), чтобы принудительно обновить значения всех 

переменных в окне. 

 

Масштаб 
 

Позволяет пользователю изменять масштаб главного окна программы. 
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Раздел 7: Редактор BoxWriter© Elite 

 
Задать 

 

Коробки 
 

Для того чтобы задать информацию о коробках, 

выберите Define > Boxes (Задать > Коробки). 

 

Чтобы добавить новую коробку, нажмите Add 

(Добавить). Введите длину (Length), ширину (Width), 

высоту (Height) и название (Name) коробки. Длина, 

ширина и высота могут находиться в интервале от 1 до 

40 дюймов. Поле «описание» (description) заполнять 

необязательно. 

 

Чтобы изменить параметры существующей коробки, 

выберите ее и нажмите Edit (Редактировать) или дважды 

кликните на коробке. 

 

Чтобы удалить существующую коробку, выберите ее и нажмите Delete (Удалить). Для выбора 

нескольких коробок воспользуйтесь клавишами Shift и/или Ctrl. Коробки, используемые в текущем 

задании, удалить нельзя. Перед этим нужно изменить 

параметры задания, указав другую коробку. 

 

На коробку можно добавить готовую графическую 

информацию, чтобы оператор получил четкое 

представление о том, как будет выглядеть коробка после 

выполнения печати. 

 

Добавить (Add): Позволяет оператору назначить .bmp 

или .jpg файл на одну из панелей коробки. 

 

Изменить (Edit): Позволяет оператору изменить .bmp 

или .jpg файл, назначенный на одну из панелей коробки. 

 

Удалить (Delete): Удаляет файл с панели. 
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Использование коробки 
 

Чтобы задать информацию об использовании 

коробки, выберите Define > Box usage (Задать > 

Использование коробки). 

 

Если нужно убрать коробку с заданного 

конвейера, это можно сделать здесь. По 

умолчанию все новые коробки доступны для 

всех конвейеров. Чтобы сделать это, выберите 

конвейер, затем коробку. Чтобы перенести ее в 

список «Не используются» (Restricted), нажмите 

кнопку "<". При нажатии кнопки "<<" все 

коробки для заданного конвейера будут 

перенесены с этот список независимо от того, выделены они или нет. Кнопки ">" и ">>" перенесут 

коробки в спискок «Доступны» (Available). 

 

Настройки редактора по умолчанию 
 

Чтобы задать настройки редактора по умолчанию, выберите пункт 

меню Define > Editor defaults (Задать > Настройки редактора по 

умолчанию). 

 

В этом окне можно задать единицы измерения, отображаемые в 

редакторе (Inches – дюймы, Centimeters – сантиметры, Head pixels – 

пиксели печатающей головки). 

 

Поле «Размер растягивающего элемента» (Resize handle size) 

используется компонентами с изменяемым размером (такими как 

растровое изображение). В этом поле можно задать значение от 5 

до15. С большими значениями легче менять размер компонента на 

сенсорном экране. 

 

На рисунке справа – растягивающие элементы – это восемь квадратов 

по периметру изображения. 

 

Если выбрать галочку «Предупреждать, если компоненты 

перекрываются», то при перекрывании компонентов друг другом 

пользователь увидит предупреждение. 
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Настройки компонентов по умолчанию 
 

Чтобы задать настройки компонентов по умолчанию, выберите 

пункт меню Define > Element defaults (Задать > Настройки 

компонентов по умолчанию). Чтобы изменить настройки по 

умолчанию, выберите тип компонента и нажмите Properties 

(Свойства) или дважды кликните на типе компонента. 

 

Хранящиеся здесь настройки определяют внешний вид 

создаваемых компонентов. (Описание отдельных компонентов 

можно найти в разделе Компоненты данного руководства.) 

 

Для изменения шрифта нажмите кнопку Change (Изменить). 

Окно, показанное справа, используется для изменения 

параметров шрифта по умолчанию. 

 

В выпадающем списке «Шрифт» (Font) можно найти все TrueType шрифты, установленные в системе. 

 

Поле «Размер» (Size) задает высоту 

шрифта в пикселах. 

 

Поле «Средняя ширина» (Average width) 

задает среднюю ширину символа (в 

пикселах). Значение «0» в этом поле 

означает, что будет использоваться 

ширина по умолчанию из настроек 

шрифта. 

 

Путь для резервного 

копирования базы данных 
 

При каждом завершении работы 

приложения выполняется резервное 

копирование базы данных Marksman 

Elite. Здесь можно указать путь до файла 

резервной копии. 
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Пользовательские форматы даты/времени 
 

Для того чтобы задать пользовательские форматы 

даты/времени, выберите пункт меню Define > 

Custom date/time formats (Задать > 

Пользовательские форматы даты/времени). 

 

Отображаемые здесь настройки даты/времени 

используются компонентами «Дата/время» 

(Date/time) и «Годен до» (Expiration date). 

 

Для создания нового пользовательского формата 

нажмите Add (Добавить). 

 

Для удаления существующего формата выберите его и нажмите Delete (Удалить). Для выбора 

нескольких форматов можно воспользоваться клавишами Shift и Ctrl. 

 

Для изменения существующего формата выберите его и нажмите Edit (Редактировать) или дважды 

кликните на нем. Откроется окно «Составить формат даты/времени», показанное ниже. 

 

 
 

Поле «Строка формата» (Format string) содержит заданную пользователем строку, состоящую из 

спецификаторов формата. 

 

В поле «Пример» (Sample) отображается пример строки, соответствующей формату в поле «Строка 

формата». 

 

Спецификаторы формата приведены в списке в нижней части окна. Для добавления спецификатора в 

текущую строку выберите его и нажмите Insert (Вставить) или дважды кликните по нему. 
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Возможные спецификаторы формата приведены в следующей таблице: 

 

Спецификатор Значение 

%a  Сокращенное обозначение дня недели 

%A День недели полностью 

%b  Сокращенное обозначение месяца 

%B Месяц полностью 

%c Локальное представление даты и времени 

%d День месяца в виде десятичного числа (01 - 31) 

%%D День месяца в виде десятичного числа (произвольной длины) 

%%-D День месяца в виде десятичного числа, выровненный влево (произвольной 

длины) 

%#d День месяца в виде десятичного числа; без ведущего нуля (1-31) 

%H Час в 24-часовом формате с ведущим нулем (00 - 23) 

%#H Час в 24-часовом формате без ведущего нуля (0-23) 

%H:%M:%S 

 

Часы: Минуты: Секунды в 24-часовом формате с ведущим нулем для часа 

(00-23) 

%#H:%M:%S 

 

Часы: Минуты: Секунды в 24-часовом формате без ведущего нуля для часа 

(00-23) 

%I Час в 12-часовом формате (01 - 12) 

%#I Час в 12-часовом формате без ведущего нуля (1-12) 

%I:%M:%S Часы: Минуты: Секунды в 12-часовом формате с ведущим нулем для часа 

(1-12) 

%#I:%M:%S Часы: Минуты: Секунды в 12-часовом формате без ведущего нуля для часа 

(1-12) 

%j День года в виде десятичного числа (001 - 366) 

%m Месяц в виде десятичного числа (01 - 12) 

%M Минута в виде десятичного числа (00 - 59) 

%%M Месяц в виде десятичного числа (произвольной длины) 

%%-M Месяц в виде десятичного числа, выровненного влево (произвольной 

длины) 

%p Индикатор AM/PM для 12-часового времени 

%S Секунда в виде десятичного числа (00 - 59) 

%U Неделя года в виде десятичного числа; первый день недели – воскресенье 

(00 -53) 

%w  День недели в виде десятичного числа (0 - 6; воскресенью соответствует 0) 

%W Неделя года в виде десятичного числа; первый день недели – понедельник 
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(00 - 53) 

%x Локальное представление даты 

%X Локальное представление времени 

%y Год без столетия в виде десятичного числа (00 - 99) 

%Y Год со столетием в виде десятичного числа 

%%Y Год в виде десятичного числа (произвольной длины) 

Примеры: 

"%%YYYY" соответствует "2004" 

"%%YY" соответствует "04" 

"%%Y" соответствует "4" 

%%-Y Год в виде десятичного числа, выровненного влево (произвольной длины) 

%z; %Z Полное или сокращенное название временной зоны; если временная зона 

неизвестна – пустая строка 

%% Знак процента 

%%0H Код часа 

%%0M Код месяца 

%%0A Код дня 

%%0Q Код четверти часа 

ПРИМЕЧАНИЕ: Перед любым спецификатором формата можно указать флаг #.С этим флагом 

значение спецификатора изменяется следующим образом: 

%#a, %#A, 

%#b, %#B, 

%#p, %#X, 

%#z, %#Z, 

%#% 

# флаг игнорируется 

%#c Подробное локальное представление даты и времени. Например: «Вторник, 

14 марта 1995 г. 12:41:29» 

%#x Подробное локальное представление даты. Например: «Вторник, 14 марта 

1995 г.» 

%#d, %#H, 

%#I, %#j, 

%#m, %#M, 

%#S, %#U, 

%#w, %#W, 

%#y, %#Y 

Удаление ведущих нулей (если они есть) 
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Коды даты/времени 
 

Выберите пункт меню Configure > System > Date/Time Codes (Настройки > Системные > Коды 

даты/времени). 

 

Конвейер (Line): В этом поле отображается 

выбранный конвейер. 

 

Для выбора таблицы кодов даты/времени выберите 

соответствующую вкладку. Затем выберите запись в 

таблице, кликнув в нужной строке. Для изменения 

данных в этой строке нажмите Edit (Редактировать). 

 

Нажмите OK для сохранения изменений и выхода 

или Cancel для выхода без сохранения изменений. 

 

Месяцы (Months): Здесь находятся строки, 

используемые в качестве кодов для обозначения 

стандартных месяцев года. 

 

Часы (Hours): В таблице «Часы» находятся двадцать 

четыре кода часов дня. Коды можно изменить для 

специального кодирования. 

 

Четверти часа (Quarter Hours): В этой таблице хранятся коды для 15-минутных интервалов. 

 

Дни (Days): В таблице «Дни» хранятся значения для представления дней. 

 

Переход даты (Rollover): Момент времени, в 

который значение текущей даты и «годен до» 

изменятся  на новое значение. По умолчанию это 

изменение выполняется в полночь. 

 

«Удерживать» ("Hold"): Удерживать дату и «годен 

до» до перехода даты. 
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Редактор растровых изображений 
 

Чтобы задать настройки редактора растровых 

изображений, выберите пункт меню Define > 

Bitmap settings (Задать > Настройки редактора 

растровых изображений). 

 

Поле «Редактор растровых изображений» (Bitmap 

editor) задает программу, используемую для 

редактирования растровых изображений. По 

умолчанию это Microsoft® Paint. Чтобы изменить 

ее, нажмите «Обзор» (Browse) и укажите путь к 

программе. 

 

Редактор этикеток 
 

Используется для настройки ПО, когда Marksman Elite используется с аппликатором этикеток. 

 

Коды смены 
 

Для того чтобы задать коды смены, выберите пункт 

меню Define > Shift codes (Задать > Коды смены). 

Коды смены используются в компонентах смены. 

 

Длина кода смены может составлять от 1 до 15 

символов. Чем позже смена, тем больше должен 

быть ее номер (например, смена с номером 1 не 

может быть позже смены с номер 2 или 3). 

 

Конвейер (Line): В этом поле задается конвейер, 

для которого определяются смены. 

 

Выберите необходимый конвейер. Введите время 

начала смен и пользовательские обозначения. Время начала смены нужно вводить в 24-часовом 

формате. Код смены может содержать до 15 буквенно-цифровых символов. 

 

В приведенном примере смена 1 начинается в 7:00, смена 2 – в 15:00, а смена 3 – в 23:00. 
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Вспомогательные компоненты 
 

Чтобы задать вспомогательные компоненты выберите пункт меню Define > Sub-elements (Задать > 

Вспомогательные компоненты). 

 

Вспомогательные компоненты могут использоваться некоторыми штрихкодами (см. раздел 

Штрихкоды). Окно «Вспомогательные компоненты» приведено ниже. 

 

 
 

Чтобы создать новый вспомогательный компонент, нажмите кнопку "+". 

 

Чтобы удалить существующий вспомогательный компонент, выберите его и нажмите кнопку "X". 

 

Чтобы изменить существующий вспомогательный компонент выберите его и нажмите на кнопку 

Properties (Свойства) (крайняя кнопка слева в нижнем ряду). Диалог свойств вспомогательного 

компонента показан ниже. 

 

 
 

Поле "ID" (идентификатор) определяет вспомогательный компонент. 
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В поле «Тип вспомогательного компонента» ("Element type") задается тип вспомогательного 

компонента. Возможны следующие типы: 

 Текстовый (Text) 

 Счетчик (Count) 

 Дата/время (Date / time) 

 «Годен до» (Expiration date) 

 Смена (Shift) 

 Пользователь (User) 

 Последовательные данные (Serial data) 

 

Чтобы изменить значение вспомогательного компонента по умолчанию, нажмите на кнопку 

Properties (Свойства). Примеры окон для компонентов различных типов приведены в разделе 

Компоненты. 

 

В поле «Описание» (Description) содержится подробное описание вспомогательного компонента. 

 

В поле «Данные» (Data) содержатся данные по умолчанию для вспомогательного компонента. Поле 

«Данные» должно удовлетворять входной маске (Input mask). 

 

Поле «Входная маска» (Input mask) определяет, какие 

данные может принимать вспомогательный компонент. 

Чтобы ее изменить, нажмите кнопку Build (Создать). 

Окно построения маски приведено справа. 

 

В этом примере маска соответствует данным, состоящим 

из двух цифр и десяти буквенно-цифровых символов. 

 

В правой части окна находятся следующие кнопки 

(сверху вниз): 

 Переместить вверх – перемещает выбранную 

маску вверх. 

 Переместить вниз – перемещает выбранную маску вниз. 

 Свойства – отображает свойства маски для редактирования. 

 Добавить – создает новую маску. 

 Удалить – удаляет выбранную маску. 
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Далее приведен пример окна свойств маски: 

 Тип «Alpha» (буквы) соответствует заглавным буквам 

от «A» до «Z». 

 Тип «Numeric» (цифры) соответствует цифрам от 0 до 

9. 

 Тип «Alphanumeric» (буквы и цифры) соответствует 

заглавным буквам от «A» до «Z» и цифрам от 0 до 9. 

 Тип «Punctuation» (символы пунктуации) соответствует 

таким символам как "," или ":". 

 Тип «Any» (любой) соответствует любому символу. 

 

 

 

 

 

 

Идентификаторы использования 
 

Для того чтобы задать идентификаторы 

использования выберите пункт меню Define > 

Application identifiers (Задать > Идентификаторы 

использования).  

 

Идентификаторы использования также могут 

использоваться некоторыми штрихкодами. Они 

работают точно так же как вспомогательные 

компоненты. 

 

Пример окна свойств идентификатора 

приложения приведен справа. 

 

Можно изменять только поля «Тип компонента» 

(Element type) и «Данные» (Data). Описание этих 

полей приведено в разделе Вспомогательные 

компоненты. 
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Глобальные параметры штрихкодов 
 

Для задания параметров штрихкодов выберите пункт меню Define > Global Barcode Parameters 

(Задать > Глобальные параметры штрихкодов). 

 

 
 

Выберите конвейер (Line), а затем тип печатающей головки (Head type). У головок с 32 каналами и с 

256 каналами есть собственные наборы параметров штрихкодов. 

 

Для просмотра или изменения набора параметров штрихкодов выберите его и нажмите Edit 

(Изменить) или дважды кликните на нем. 

 

ПРИМЕЧАНИЯ: 

 

Ширина полосы и пространства между полосами может быть изменена только в 

пользовательских наборах параметров, производить эти изменения должно только лицо, 

обладающее достаточными знаниями штрихкодов и системы печати струйных принтеров. 

Неверное заданные параметры могут привести к печати нераспознаваемых штрихкодов. 

 

C128, C39, C93 и I 2of5: Увеличение (Magnification), ширину (Width), общую высоту (Total height) и 

сотношение (Ratio) нельзя изменить в стандартных наборах параметров штрихкодов. Эти поля можно 

изменить только в пользовательских наборах параметров штрихкодов. 

 

UPC: Увеличение (Magnification), ширину полосы (Bar) и ширину свободного пространства (Space) 

нельзя изменить в стандартных наборах параметров штрихкодов. Эти поля можно изменить только в 

пользовательских наборах параметров штрихкодов. 
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Справа приведен пример параметров штрихкода для 

штрихкодов UPCA. 

 

В поле «Увеличение» (Magnification) отображается 

значение из одноименного поля окна глобальных 

параметров штрихкодов. 

 

Поле «Высота полоски» (Bar height) содержит общую 

высоту полоски в пикселах. 

 

В полях «Ширина полоски» (Bar width) и «Ширина 

промежутка» (Space width) задается ширина 

полоски/промежутка в пикселах. 

 

В поле «Название шрифта» (Font name) находится 

выпадающий список всех шрифтов TrueType, 

установленных в системе. 

 

В поле «Размер шрифта» (Font size) содержится высота шрифта в пикселах. 

 

В поле «Средняя ширина» (Average width) задается средняя ширина символа (в пикселах). Значение 0 

означает, что будет использована ширина шрифта по умолчанию. 

 

 В поле «Увеличение» (Magnification) отображается 

значение из одноименного поля окна глобальных 

параметров штрихкодов. 

 

В поле «Общая высота» задается общая высота в 

пикселах. 

 

В поле «Горизонтальное основание» (Horz. Bearer) 

задается ширина горизонтального основания в 

тысячных долях дюйма. 

 

В поле «Вертикальное основание» (Vert. Bearer) 

задается ширина вертикального основания в 

тысячных долях дюйма. 

 

В поле «Тихая зона» (Quiet zone) задается ширина 

«тихой зоны» в тысячных долях дюйма. 

 

В поле «Название шрифта» (Font name) находится 

выпадающий список всех шрифтов TrueType, установленных в системе. 

 

В поле «Размер шрифта» (Font size) содержится высота шрифта в пикселах. 
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Параметры 

 

Использование чернил 
 

Калькулятор использования чернил подсчитает стоимость каждой печати и количество операций 

печати, на которые хватило каждой емкости с чернилами. 

 

 
 

 
Файл 

 

Создать 
 

Для создания нового задания выберите пункт меню File > 

New (Файл > Создать). 

 

Откроется диалоговое окно, приведенное справа. Выберите 

конвейер, для которого необходимо создать задание 

(Production line), дайте заданию имя (Task name) и описание 

(Description) и выберите коробку, на которой будет 

выполняться печать (Box). 

 

В поле «Название задания» (Task name) можно вводить 

только буквы и цифры, запрещается вводить пробелы и 

специальные символы. Максимальная длина названия 

задания – 32 символа. 
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Создание задания 
 
Следующий этап – добавить компоненты на изображение, которое будет напечатано. Области, 

показывающие расположение печатающих головок, выделяются красным цветом. Области печати 

нельзя изменить в редакторе, потому что информация о головках и об их положении по отношению к 

коробке берется из настроек системы, которые ограничены физическим расположением 

установленных устройств. Компоненты можно добавлять на различные панели. После выбора панели 

выберите элемент, который нужно поместить на нее. Процесс повторяется до тех пор, пока вся 

необходимая информация не будет размещена на панелях. Затем нужно сохранить задание. 

(Обратитесь в соответствующие разделы руководства по компонентам и сохранению файлов.) 

 

 
 

 

ПРИМЕЧАНИЕ: Если два компонентов перекрываются, они оба будут показаны 

красным цветом, что говорит оператору о возможных проблемах. Оператор также получит 

соответствующее предупреждение в процессе сохранения задания. 

 

 

Чтобы предупреждения при перекрывании компонентов не отображались, выполните действия, 

описанные в главе Задать, Настройки редактора по умолчанию ранее в этом разделе. 
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Открыть 
 

Чтобы открыть существующее задание, выберите пункт 

меню File > Open (Файл > Открыть). 

 

Выберите задание, которое нужно открыть, и нажмите OK; 

или дважды кликните на нем. 

 

Если выбрать галочку «Открывать в режиме только для 

чтения» (Open read only), то задание будет открыто в режиме 

только для чтения (т.е. пользователь не сможет изменить 

задание). 

 

Если выбрать галочку «Предварительный просмотр» (Show 

preview), то для выбранного задания будет показан 

предварительный просмотр. Для больших заданий на 

создание просмотра может потребоваться несколько секунд. 
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Копировать 
 

Чтобы скопировать задания с одного конвейера на другой, выберите пункт меню File > Copy (Файл > 

Копировать). 

 

 
 

Выберите конвейер, с которого нужно скопировать задания, затем выберите задания, которые нужно 

скопировать. При выборе галочки «Все» (All) будут автоматически выбраны все задания для данного 

конвейера. 

 

После выбора заданий нажмите кнопку Copy (Копировать). 

 

Если все завершилось удачно, вы увидите сообщение, похожее на 

приведенное справа. 

 

Затем поля «С» (From) и «На» (To) снова можно изменить и снова 

выполнить копирование. 

 

Затем нажмите на кнопку OK чтобы сохранить изменения. 
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Эта функция лучше всего работает тогда, когда у 

конвейеров, указанных в полях «С» (To) и «На» (From), 

конфигурация печатающих головок одинакова. Однако, 

если она не одинакова, пользователь может изменить ее, 

сопоставив различные печатающие головки разных 

конвейеров. Для этого выберите головку, свойства 

которой нужно изменить, и нажмите Edit (Редактировать) 

или дважды кликните на ней. 

 

Откроется окно, приведенное справа. Выберите головку, с которой нужно сопоставить данную 

головку, в поле «На» (To) и нажмите OK. 

 

При нажатии кнопки Properties (Свойства) 

откроется окно свойств печатающей головки. 

Обратите внимание, что в редакторе свойства 

печатающей головки изменить нельзя. 
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Импорт 
 

 

ПРИМЕЧАНИЕ: Рекомендуется остановить все задания печати до того момента, как 

функция импорта будет завершена, и экспортировать текущую базу данных для создания 

резервной копии. 

 

Чтобы импортировать все ранее экспортированные задания, выберите пункт меню File (Файл), затем 

Import (Импорт). 

 

В поле «Имя файла» (Filename) введите полный путь к файлу, содержащему экспортированные 

задания, или найдите этот файл с помощью кнопки Browse (Обзор). 

 

Если в контроллере есть данные, которые не стоит терять, нажмите Yes (Да) в следующем окне. 

 

 
 

После завершения импорта появится окно, приведенное 

справа. 
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Экспорт 
 

 

ПРИМЕЧАНИЕ: Рекомендуется остановить все задания печати до того момента, как 

функция экспорта будет завершена. 

 

Чтобы экспортировать все существующие задания, 

выберите пункт меню File (Файл), затем Export 

(Экспорт). 

 

В поле «Имя файла» (Filename) введите полный путь к 

файлу, в который нужно экспортировать данные, или 

укажите существующий файл с помощью кнопки 

Browse (Обзор). Нажмите на кнопку Export (Экспорт). Если файл уже существует, будет предложено 

перезаписать его или отменить операцию. 

 

После успешного экспортирования появится соответствующее сообщение. 

 

Удалить 
 

Для удаления существующих заданий выберите пункт 

меню File > Delete (Файл > Удалить). 

 

Выберите задания, которые нужно удалить. Для выбора 

нескольких заданий можно воспользоваться клавишами 

Shift и Ctrl. Когда задания выбраны, нажмите Delete 

(Удалить). 

 

Удаление можно выполнять несколько раз, не закрывая 

окно. Можно удалять задания на разных конвейерах. 

 

Нажмите OK для сохранения изменений. 

 

Если выбрать галочку «Предварительный просмотр» 

(Show preview) будет отображаться предварительный 

просмотр для выбранного задания. Для больших 

заданий на создание предварительного просмотра 

может потребоваться несколько секунд. 
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Сохранить как 
 

Чтобы сохранить открытое задание под другим именем, 

выберите пункт меню File > Save as (Файл > Сохранить как). 

 

Поле «Файл» (File) должно содержать только буквы и цифры; 

пробелы и специальные символы вводить нельзя. 

Максимальная длина этого поля – 32 символа. 

 

 

 

 

 

 

 

 

Если задание с таким именем уже есть в базе 

данных, появится окно, приведенное справа. 

 

Свойства 
 

Чтобы изменить свойства открытого задания, выберите пункт меню File > Properties (Файл > 

Свойства). В этом окне можно изменить описание задания (Description), строку загрузки (Download 

string), коробку (Box) и/или поле «Годен до» (Expiration data). 
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В следующей таблице перечислены специальные символы ASCII, которые можно вводить в поле 

«Строка загрузки» (Download String). Например, чтобы отправить строку «0012345», завершаемую 

возвратом каретки, введите в этом поле «0012345<CR>». 

 

Символ Описание 

<NULL> Нуль (null) 

<SOH> Начало заголовка 

<STX> Начало текста 

<ETX> Конец текста 

<EOT> Конец передачи 

<ENQ> Запрос 

<ACK> Подтверждение 

<BEL> Звонок 

<BS> Возврат 

<HT> Горизонтальная табуляция 

<LF> Перевод строки, новая строка 

<VT> Вертикальная табуляция 

<FF> Перевод страницы, новая страница 

<CR> Возврат каретки 

<SO> Изменить цвет ленты; переключение кодировки 

<SI> Обратное переключение к SO 

<SLE>  

<DC1> 1-й символ управления устройством  

<DC2> 2-й символ управления устройством  

<DC3> 3-й символ управления устройством  

<DC4> 4-й символ управления устройством  

<NAK> Подтверждения нет 

<SYN> Синхронизация 

<ETB> Конец блока передачи 

<CAN> Отмена 

<EM> Кончился носитель 

<SIB> Замена 

<ESC> Отмена 

<FS> Разделитель файла 

<GS> Разделитель групп 

<RS> Разделитель записей 

<US> Разделитель модулей 

 

 

Выход 
 

Для выхода из редактора выберите пункт меню File > Exit (Файл > Выход). 
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Компоненты 

 

Панель компонентов 
 

 
 

С помощью панели компонентов пользователь может добавлять компоненты в задание. На панели 

находятся компоненты следующих типов (слева направо): 

 Текст (Text) 

 Растровое изображение (Bitmap) 

 Счетчик (Count) 

 Дата/время (Date / time) 

 Годен до (Expiration date) 

 Пользовательский компонент (User) 

 Смена (Shift) 

 Штрихкод (Barcode) 

 База данных (Database) 

 Последовательные данные (Serial) 

 

Для добавления новых компонентов можно нажать одну из кнопок на панели инструментов, либо 

кликнуть правой кнопкой на одной из печатных областей коробки, либо воспользоваться меню 

Elements > Add (Компоненты > Добавить). 

 

При создании нового компонента его левый верхний угол располагается в месте текущего положения 

перекрестия курсора мыши. 

 

Для изменения свойств компонента кликните на нем, затем выберите пункт меню Elements > Edit 

(Компоненты > Изменить) (или нажмите Enter), либо дважды кликните на компоненте. Изменять 

компоненты можно только по одному. 
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Текст 
 

Свойства компонента «Текст» (Text) показаны справа. Текст 

можно ввести в поле либо одной строкой, либо в несколько 

строк с абзацами. Для перехода на следующую строку 

нажмите Ctrl + Enter. Курсор будет перемещен в следующую 

строку, в которую тоже можно будет ввести текст. 

 

Средняя ширина (Average width) задает среднюю ширину 

символа (в пикселах). Значение «0» означает, что будет 

использована ширина из настроек шрифта. 

 

В поле «Текст» (Text) отображается текст, который будет 

напечатан. В этом поле может быть от одного до 255 

символов. 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст 

печататься горизонтально или вертикально. 

 

Linked to (Связать с...): Позволяет пользователю связать компонент текста с компонентом штрихкода. 

При изменении штрихкода текст автоматически изменится. 

 

Рисунок 1: Горизонтальная ориентация 

 

 

 

 

 

 

Рисунок 2: Вертикальная ориентация 
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Для вставки специальных символов нажмите на кнопку Special (Специальные символы). Откроется 

стандартное окно «Символы» Windows, в котором можно найти, скопировать и вставить специальные 

символы. 

 

 

 

Растровое изображение 
 

Окно свойств растрового изображения показано справа. 

 

В поле «Имя файла» (Filename) отображаются полный путь и имя 

файла выбранного изображения. Для выбора другого изображения 

нажмите кнопку Browse (Обзор). 

 

Чтобы отредактировать выбранное изображение в редакторе по 

умолчанию, нажмите Edit (Редактировать). Обратите внимание, 

что в этом случае редактор BoxWriter© будет заблокирован до тех 

пор, пока не будет закрыт редактор. Инструкции по изменению 

редактора растровых изображений по умолчанию приведены в 

разделе Задать, Настройки редактора растровых изображений 

данного руководства. 

 

В полях «Ширина» (Width) и «Высота»  (Height) отображаются ширина и высота изображения. 
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Счетчик 
 

Окно свойств счетчика приведено справа. 

 

Средняя ширина (Average width) задает среднюю 

ширину символа (в пикселах). Значение «0» 

означает, что будет использована ширина из 

настроек шрифта по умолчанию. 

 

С помощью поля «Имя» (Name) можно изменить 

описание счетчика. Можно задать до двух 

уникальных счетчиков. 

 

«Главный счетчик» (Master Count) – компонент, 

которым можно управлять с помощью изменений 

данного счетчика. 

 

Если установить галочку «Главный» (Master), то 

данный счетчик будет управлять всеми счетчиками 

для заданного сообщения и разблокирует настройки 

других счетчиков в начале выполнения задания. 

 

В поле «Начальное значение» отображается начальное значение счетчика. 

 

В поле «Сбрасывать после» (Roll over on) отображается значение, по достижении которого счетчик 

будет сброшен в начальное значение. (Максимальное количество знаков в этом поле – шесть.) 

 

В поле «Увеличивать на...» (Increment by) отображается приращение счетчика за одно срабатывание 

фотоэлемента. 

 

В поле «Количество цифр» отображается количество значащих цифр, которые выводятся на печать. 

Если выбрана галочка «Ведущие нули», значение будет дополнено нулями слева. В приведенном 

примере будет напечатано «000001». 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст печататься горизонтально или 

вертикально. Примеры горизонтальной и вертикальной ориентации текста приведены в разделе 

Компоненты, Текст.
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Для счетчика стеллажей перейдите на вкладку «Счетчик 

стеллажей» (Pallet count) и установите галочку Enabled 

(Активировано). Поля «Начальное значение» (Start value) 

«Сбрасывать после» (Roll over on) и «Увеличивать на...» 

аналогичны одноименным полям на вкладке «Счетчик 

коробок» (Box count) (см. предыдущий пример). 

 

Поле «Количество коробок в стеллаже» (Units per pallet) 

обозначает число коробок, загружаемых в один стеллаж. 

 

Текущее количество стеллажей увеличивается на 

единицу после того, как значение счетчика достигает 

количества коробок в стеллаже. Например, если в 

стеллаже 144 коробки, и это значение введено в поле 

«Количество коробок в стеллаже», после печати 144 

коробок значение количества стеллажей будет 

увеличино на единицу. 

 

Галочка «Сбрасывать» (Rollover) будет сбрасывать счетчик стеллажей в начальное значение после 

того, как будет достигнуто максимальное значение (Maximum value). Если эта галочка не выбрано, 

максимальное значение будет увеличиваться одновременно со счетчиком стеллажей. 

 

Компонент даты/времени 
 

Окно свойства компонента даты/времени приведено справа. 

 

Средняя ширина (Average width) задает среднюю ширину символа 

(в пикселах). Значение «0» означает, что будет использована 

ширина из настроек шрифта по умолчанию. 

 

Поле «Формат» (Format) определяет, как будет напечатана текущая 

дата или время. Список существующих форматов приведен в 

разделе Задать, Пользовательские форматы даты/времени 

данного руководства. 

 

Для создания нового формата нажмите кнопку Build (Создать). 

Описание окна создания формата даты/времени приведено в 

разделе Задать, Пользовательские форматы даты/времени 

данного руководства. 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст печататься горизонтально или 

вертикально. Примеры горизонтальной и вертикальной ориентации текста приведены в разделе 

Компоненты, Текст. 
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Годен до 
 

Окно свойств компонента «Годен до» приведено справа. 

 

Средняя ширина (Average width) задает среднюю ширину 

символа (в пикселах). Значение «0» означает, что будет 

использована ширина из настроек шрифта по умолчанию. 

 

Поле «Формат» (Format) определяет, как будет напечатана 

текущая дата или время. Список существующих форматов 

приведен в разделе Задать, Пользовательские форматы 

даты/времени данного руководства. 

 

Для создания нового формата нажмите кнопку Build (Создать). 

Описание окна создания формата даты/времени приведено в 

разделе Задать, Пользовательские форматы даты/времени 

данного руководства. 

 

Дата «Годен до» определяется путем добавления указанного количества дней (Days) и 

часов/минут/секунд (HH:MM:SS) к текущему системному времени. 

 

Галочка «Округлять до следующей единицы измерения» (Round to top of unit) округлит дату до 

следующей единицы измерения. 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст печататься горизонтально или 

вертикально. Примеры горизонтальной и вертикальной ориентации текста приведены в разделе 

Компоненты, Текст. 

 

Если выбрана галочка «Переход даты» (Rollover) можно задать время смены даты, отличное от 

полуночи. Указание по вводу нового значения приведены в разделе Коды даты/времени, Переход 

даты. 
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Пользовательский компонент 
 

Окно свойств пользовательского компонента приведено 

справа. 

 

Средняя ширина (Average width) задает среднюю ширину 

символа (в пикселах). Значение «0» означает, что будет 

использована ширина из настроек шрифта по умолчанию. 

 

В поле «Данные» (Data) отображаются данные, которые 

будут напечатаны. Если выбрана галочка «Использовать 

символ по умолчанию» (Use default character), отображаемые 

в редакторе данные будут заменены символом «W». В 

данном примере в редакторе будет показано 

«WWWWWWWWWWWWWWW» (15 «W», так как 

максимальное количество символов (Max chars) установлено 

в 15). 

 

Если установлена галочка «Запрашивать перед началом 

выполнения задания» (Prompt at task start), приложение 

запросит вводимые данные перед началом выполнения 

задания. Сообщение в окне запроса ввода определяется полем «Текст запроса» (Prompt). 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст печататься горизонтально или 

вертикально. Примеры горизонтальной и вертикальной ориентации текста приведены в разделе 

Компоненты, Текст. 

 

Смена 
 

Окно свойств смены показано справа. 

 

Компонент смены печатает код текущей смены. Более подробная 

информация приведена в разделе Задать, Коды смены. 

 

Средняя ширина (Average width) задает среднюю ширину символа (в 

пикселах). Значение «0» означает, что будет использована ширина из 

настроек шрифта по умолчанию. 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст печататься 

горизонтально или вертикально. Примеры горизонтальной и вертикальной 

ориентации текста приведены в разделе Компоненты, Текст. 
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Штрихкод 
 

Окно свойств компонента штрихкода показано справа. 

 

В поле «Символика» (Symbology) отображается тип 

штрихкода. Поддерживаются следующие типы 

штрихкодов: 

 I 2of5 

 UPCA 

 C39 

 C93 

 C128 

 

Поле «Увеличение» (Magnification) содержит масштаб 

отображения штрихкода. Более подробная информация 

по параметрам штрихкодов приведена в разделе Задать, 

Параметры штрихкодов данного руководства. 

 

Поле «Данные» содержит цифровой ряд, 

закодированный штрихкодом. 
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Штрихкоды типа C128 поддерживают вспомогательные компоненты и идентификаторы 

использования. Для их изменения снимите галочку «Простые данные» (Simple data). Далее приведен 

пример штрихкода типа C128 с двумя вспомогательными компонентами: 

 

 
 

В правой части окна расположены следующие кнопки (сверху вниз): 

 Вверх – перемещает выбранный вспомогательный компонент вверх 

 Вниз – перемещает выбранный вспомогательный компонент вниз 

 Свойства – отображает свойства выбранного вспомогательного компонента 

 Добавить ИП (AI) – добавляет новый идентификатор использования 

 Добавить вспомогательный компонент – добавляет вспомогательный компонент 

 

Более подробная информация приведена в разделах Задать, Вспомогательные компоненты и Задать, 

Идентификаторы использования. 
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База данных 
 

Окно свойств базы данных показано справа. 

 

Компонент базы данных запрашивает необходимые 

данные из заданной базы данных и выводит их. 

 

Средняя ширина (Average width) задает среднюю 

ширину символа (в пикселах). Значение «0» означает, 

что будет использована ширина из настроек шрифта по 

умолчанию. 

 

В поле «Имя источника данных» (DSN) отображается 

имя выбранной базы данных ODBC. Для выбора 

другой базы данных нажмите Browse (Обзор). При 

нажатии этой кнопки откроется диалог «Выбор 

источника данных» (Select Data Source). Он показан на 

следующей странице. 

 

В поле «Таблица (Table) отображается имя таблицы в 

базе данных, к которой выполняется запрос. 

 

В поле «Поле» (Field) отображается имя поля в выбранной таблице. Именно значение этого поля и 

будет напечатано. Для выбора поля из текущей таблице воспользуйтесь кнопкой Select (Выбрать). 

Окно выбора поля приведено на следующей странице. 

 

Если получение значения поля осуществляется по ключу, поставьте галочку «Использовать» (Use) 

под полем «Ключ» (Key field). В данном примере будет выбрана запись из таблицы Messages с 

идентификатором (ID) 2434. Значение поля Name этой записи будет напечатано. Поле ключа (Key 

Field) можно выбрать с помощью кнопки Select (Выбрать). Окно выбора поля показано на следующей 

странице. 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст печататься горизонтально или 

вертикально. Примеры горизонтальной и вертикальной ориентации текста приведены в разделе 

Компоненты, Текст. 
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Ниже приведен пример окна выбора источника данных: 

 

 
 

Ниже приведен пример окна выбора поля: 
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Для ввода непосредственного SQL-запроса перейдите на 

вкладку «Общее выражение» (General statement). Пример 

окна приведен справа. В этом случае будет напечатано 

значение первого поля первой записи результата. 
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Последовательные данные 
 

Окно свойств последовательных данных приведено справа 

 

Данный компонент выводит данные из последовательного буфера. 

Последовательный буфер задается в программе управления 

Marksman© Elite Control. 

 

Средняя ширина (Average width) задает среднюю ширину символа 

(в пикселах). Значение «0» означает, что будет использована 

ширина из настроек шрифта по умолчанию. 

 

В поле «Индекс начала» задается индекс начала копируемых 

данных в последовательном буфере. 

 

Поле «Длина» (Length) определяет, сколько символов будет скопировано из последовательного 

буфера. 

 

Поле «Ориентация» (Orientation) определяет, будет ли текст печататься горизонтально или 

вертикально. Примеры горизонтальной и вертикальной ориентации текста приведены в разделе 

Компоненты, Текст. 

 

В редакторе компонент последовательных данных будет 

отображаться с помощью букв «W». В данном примере он будет 

выглядеть так: 
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Панель инструментов 

 
 

Иконки на панели инструментов приведены в таблице в порядке слева направо: 

 

Кнопка Пункт меню Комбинация клавиш 

New (Создать) File > New  (Файл > Создать) Ctrl + N 

Open (Открыть) File > Open (Файл > Открыть) Ctrl + O 

Save (Сохранить) File > Save (Файл > Сохранить) Ctrl + S 

Save all (Сохранить все) File > Save all (Файл > Сохранить все)  

Cut (Вырезать) Edit > Cut (Редактировать > Вырезать) Ctrl + X 

Copy (Копировать) Edit > Copy (Редактировать > Копировать) Ctrl + C 

Paste (Вставить) Edit > Paste (Редактировать > Вставить) Ctrl + V 

Undo (Отменить) Edit > Undo (Редактировать > Отменить) Ctrl + Z 

Redo (Повторить) Edit > Redo (Редактировать > Повторить) Ctrl + Y 

Zoom In (Увеличить 

масштаб) 

View > Zoom> In (Просмотр > Масштаб > 

Увеличить) 

+ 

Zoom Out (Уменьшить 

масштаб) 

View > Zoom> Out (Просмотр > Масштаб 

> Уменьшить) 

- 

Zoom normal (Обычный 

масштаб) 

View > Zoom> Normal (Просмотр > 

Масштаб > Обычный) 

 

Zoom custom (Задать 

масштаб) 

View > Zoom> Custom (Просмотр > 

Масштаб > Задать) 

 

Fit View to screen (По 

ширине экрана) 

View > Zoom > Fit to Screen (Просмотр > 

Масштаб > По ширине экрана) 

 

About (О программе) Help > About (Справка > О программе) F1 

 

Создать 
 

Создает новое задание. См. раздел Файл, Создать. 

 

Открыть 
 

Открывает существующее задание. См. раздел Файл, Открыть. 

 

Сохранить 
 

Сохраняет редактируемое задание. 

 

Сохранить все 
 

Сохраняет все открытые задания. 

 

Вырезать 
 

Вырезает выбранные компоненты и помещает их в буфер обмена. 
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Копировать 
 

Копирует выбранные компоненты в буфер обмена. 

 

Вставить 
 

Вставляет содержимое буфера обмена в текущее задание. 

 

Новые компоненты, создаваемые в результате этой операции, будут размещены в точке, в которой 

находится перекрестие курсора мыши. 

 

Отменить 
 

Отменяет последнюю операцию. 

 

Повторить 
 

Повторяет последнюю отмененную операцию. 

 

Увеличить масштаб 

 
Увеличивает текущий масштаб на 25%. 

 

Уменьшить масштаб 
 

Уменьшает текущий масштаб на 25%. 

 

Обычный масштаб 
 

Устанавливает текущий масштаб в 100%. 

 

Задать масштаб 

 
Эта команда позволяет задать произвольный масштаб. 

Возможные значения – от 10% до 200%. 

 

По ширине экрана 
 

Устанавливает текущий масштаб по ширине экрана. 
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О программе 
 

При нажатии этой кнопки отображается окно «О 

программе». В нем приведен список основных 

компонентов редактора с номерами версий. 

 

Панель выбора шрифта 

 
Панель выбора шрифта позволяет изменить шрифт у 

любых компонентов, у которых он есть (например, 

«Текст», «Счетчик», «Дата/время»). 

 

Название 
 

Название выбранного в данный момент шрифта. 

 

Размер 
 

Высота шрифта в пикселах. 

 

Ширина 
 

Задает среднюю ширину символа (в пикселах). Значение «0» в этом поле означает, что будет 

использоваться ширина по умолчанию из настроек шрифта. 

 

Если одно из полей перекрывает другое, оба поля будут выделены красным. 
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Панель поворота 
 

Панель поворота позволяет изменить положение коробки по отношению к 

печатающим головкам. 

 

На ней расположены кнопки, выполняющие следующие повороты (слева направо): 

 Против часовой стрелки 

 По часовой стрелке 

 Вниз 

 Вверх 

 Влево 

 Вправо 

 

Ниже приведены иллюстрации некоторых возможных поворотов. Для начала предположим, что 

длина, ширина и высота коробки равны соответственно 12, 6 и 3 дюймам. С ориентацией по 

умолчанию в новом задании ее область печати будет составлять 3 дюйма в высоту на 6 дюймов в 

ширину: 
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Поворот коробки по часовой стрелке (или против часовой стрелки) приведет к тому, что область 

печати станет равной 6 дюймам в высоту на 3 дюйма в ширину: 
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Поворот коробки вверх (или вниз) приведет к тому, что область печати станет равной 12 дюймам в 

высоту на 6 дюймов в ширину: 
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Поворот коробки влево (или вправо) приведет к тому, что область печати станет равной 3 дюймам в 

высоту на 12 дюймов в ширину: 

 

 

 
 
Иногда поворот коробки приводит к тому, что некоторые элементы выходят за область печти. Когда 

это происходит, редактор выдает следующее предупреждение: 

 

 
 

Если затронутые компоненты можно перемещать, нажмите Yes (Да), и компоненты автоматически 

будут перемещены. В противном случае нажмите No (Нет), и коробка вернется в исходное 

положение. 
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Панель выравнивания 
 

Панель выравнивания позволяет выполнять с выбранными компонентами различные преобразования. 

 

 
 

Иконки с панели выравнивания приведены в таблице (в порядке слева направо): 

 

Кнопка Комбинация клавиш Минимальное количество 

элементов, которые нужно 

выбрать 

Влево  2 

По центру  2 

Вправо  2 

Вверх  2 

По центру  2 

Вниз  2 

По центру (на коробке)  1 

Распределить равномерно 

вертикально 

 3 

Распределить равномерно 

горизонтально 

 3 

Жирный Ctrl + B 1 

Курсив Ctrl + I 1 

Отразить горизонтально  1 

Отразить вертикально  1 

Инверсия  1 

 

 

Рисунок 1: Выравнивание по левому краю 
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Рисунок 2: Выравнивание по центру 

 

 

 

 

 

 

Рисунок 3: Выравнивание по правому 

краю 

 

 

 

 

 

 

 

Рисунок 4: Выравнивание по верхнему 

краю 

 

 

 

 

 

Рисунок 5: Выравнивание по середине 

 

 

 

 

 

Рисунок 6: Выравнивание по нижнему 

краю 

 

 

 

 

 

 

 

Рисунок 7: Выравнивание по центру (на 

коробке)  
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Рисунок 8: Равномерное распределение по 

вертикали 

 

 

 

 

 

 

 

 

 

Рисунок 9: Равномерное распределение по 

горизонтали 

 

 

 

Рисунок 10: Текстовый компонент с 

незаданной жирностью 

 

 

 

 

 

Рисунок 11: Жирность равна 3 

 

 

 

 

 

 

Рисунок 12: Отразить горизонтально 

 

 

 

 

 

Рисунок 13: Отразить вертикально 

 

 

 

 

 

Рисунок 14: Инверсия  
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Перспектива 
 

Для изменения перспективы взгляда на коробку выберите пункт 

меню View > Change perspective (Вид > Изменить 

перспективу). 

 

Перспективы по осям x и y должны быть в диапазоне от -90 до 

90 градусов. 

 

 

 

 

 

 

Рисунок 1: Перспектива с [x, y] установленными в 20, 10 
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Рисунок 2: Перспектива с [x, y] установленными в -20, 10 
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Раздел 8: Обслуживание 

 

Автоматическая система очистки сопел – Система автоматической 

заправки 
 

 

ПРИМЕЧАНИЕ: При появлении сигнала «недостаточно чернил» система не будет 

заправлена вручную или автоматически. Сигнал «недостаточно чернил» вызывается либо 

недостатком чернил в резервуаре с чернилами, либо заполнением резервуара для сбора 

отходов. 

 

Система автоматической заправки – незаменимое средство для удаления остатков чернил с 

поверхности печатающей головки. На рисунках ниже показан печать до и после автоматической 

заправки. 

 

 
ДО АВТОМАТИЧЕСКОЙ ЗАПРАВКИ 

 

 
ПОСЛЕ АВТОМАТИЧЕСКОЙ ЗАПРАВКИ 

 

 

ПРИМЕЧАНИЕ: Продолжительность цикла автоматической заправки – около 5-10 

секунд. 
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Процедура выключения 
 

 Закройте приложение (дважды кликните на X в правом верхнем углу). 

 

ПРИМЕЧАНИЕ: Чтобы закрыть приложение, необходимо иметь соответствующий 

уровень доступа. 

 Когда появится рабочий стол Windows®, выберите Start (Пуск), затем Turn Off Computer 

(Выключить компьютер). 

 Выберите Turn Off Computer (Выключить компьютер). Windows® выполнит необходимые 

действия для выключения. 

 Когда они будут закончены, экран будет полностью белым. 

 Теперь можно отключить питание. 

 

Ежедневно – каждые 8 часов 

 Протрите сенсорный экран и клавиатуру неворсистой тканью. 

 Убедитесь, что кулеры в корпусе работают. 

 Осмотрите корпуса печатающих головок на наличие утечек и при необходимости вытрите их 

неворсистой тканью. 

 

ПРИМЕЧАНИЕ: Не вытирайте рабочую поверхность печатающей головки. 

 Осмотрите электрические соединения на предмет поверждений или износа. 

 Если в печатаемом сообщении есть полосы, выполните процедуру продува головок. 

 Осмотрите направляющие конвейера и крепления печатающих головок на наличие износа. 

 

Ночной период и промежуток времени от 1 до 3 дней: 

 

Переведите систему в режим бездействия чтобы исключить любую печать. Систему можно оставить 

включенной на все это время. После окончания этого периода выполните продувку и заправку 

печатающих головок для удаления пыли и чернил, которые могли скопиться на рабочей поверхности 

печатающих головок. 

 

Промежутки времени более 3 дней: 

 

Если печатающие головки не будут использоваться более трехдней, рекомендуется выключить 

контроллер. 

 Закрыть программу. 

 Отключить систему. 

 Закройте крышку клапана резервуара. 

 Замените предохранительную крышку резервуара. 

 

После включения питания дайте головке прогреться и выполните визуальный осмотр головок перед 

использвоанием. Выполните цикл Автоматическая система очистки сопел, чтобы убедиться, что все 

каналы чисты. 

 Снимите предохранительную крышку резервуара. 

 Откройте крышку клапана резервуара. 

 Включите систему. 

 Выполните заправку, чтобы гарантировать, что любая пыль и остатки чернил, которые могли 

попасть в печатающую головку или на ее рабочую поверхность, удалены. 
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3 недели - 120 часов 

 Протрите корпуса печатающих головок и поверхности резервуаров с чернилами неворсистой 

тканью. 

 Протрите корпус принтера неворсистой тканью. 

 Квалифицированное лицо должно открыть корпус принтера и осмотреть его на наличие пыли. 

При необходимости корпус нужно продуть под низким давлением воздухом, не содержащим 

влаги и масел. 

 Осмотрите фильтр вентилятора и замените его при необходимости. Эта процедура описана 

ниже. 

 Убедитесь, что вентилятор вращается свободно. 

 

3 месяца - 500 часов 

 Протрите корпуса печатающих головок и поверхности резервуаров с чернилами неворсистой 

тканью. 

 

 

ПРИМЕЧАНИЕ: Не вытирайте рабочую поверхность печатающей головки. 

 

 Протрите корпус принтера неворсистой тканью. 

 Квалифицированное лицо должно открыть корпус принтера и осмотреть его на наличие пыли. 

При необходимости корпус нужно продуть под низким давлением воздухом, не содержащим 

влаги и масел. 

 Осмотрите фильтр вентилятора и замените его при необходимости. Для замены фильтра 

вентилятора просто снимите заслонки на внешних боковых панелях Marksman©. Фильтр 

находится под этими заслонками. Его можно очистить воздухом под низким давлением. Для 

более тщательной очистки фильтра вымойте его с мылом и дайте ему просохнуть перед 

установокой. 

 Отключив принтер от сети, убедитесь, что все кабели надежно закреплены хомутами. 

Замените недостающие хомуты или поврежденные кабели. 
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Раздел 9: Устранение неполадок 
 

В системе Marksman© Elite используются проверенные разработки как в программной, так и в 

аппаратной составляющих. Однако, если система работает неправильно, некоторые встроенные 

индикаторы могут помочь в устранении неполадок. Информация, приведенная в этом разделе, 

позволит сократить время простоя и познакомит вас с некоторыми диагностическими возможностями 

системы. 

 

Замечания по устранению неполадок 
 

Большинство проблем с контроллерами вызвано неправильным подключением кабелей. Проверьте 

все соединения, включая питание, печатающие головк, датчик скорости и фотодатчик. (Более 

подробная информация приведена в Приложении B, Теоретические сведения о работе системы.) 

 

Проблема: Невозможно связаться с контроллером Marksman© Elite по сети Ethernet. 

Действия: 

 Выключите, а затем включите компьютер и Marksman© Elite. 

 Проверьте, что кабели Ethernet подключены верно. 

 Проверьте, что IP-адреса компьютера и Marksman© Elite установлены верно. 

 

Проблема: Печать не работает. 

Действия: 

 Проверьте, что в печатающей головке нет ошибок. 

 Проверьте, что датчик скорости активирован. 

 Убедитесь, что фотоэлемент активирован и определяет наличие изделия. 

 Убедитесь, что конфигурация печатающей головки задано верно. 

 Убедитесь, что выбрана верная этикетка. 

 

Проблема: Не работает датчик скорости конвейера. 

Действия: 

 Убедитесь, что между колесиком датчика и конвейером есть контакт. 

 Убедитесь, что датчик подключен к нужному порту. 

 Проверьте, что настройки заданы верно. 
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Диагностические тесты 

 

Тест печати 
 

Данный тест проверяет работу печатающих головок. 

 

1. Поместите ткань перед рабочей поверхностью печатающей головки. 

2. Начните цикл печати, запустив конвейер и активизировав фотоэлемент. 

3. Проверьте наличие чернил на ткани. 

 

Наличие точек на ткани означает, что печать работает. Если на картоне печать не выполняется, 

проверьте смещение датчика изделия, длину изделия и поля изделия. 

 

Отсутствие чернил на ткани означает, что печать не работает. Для определения возможных причин 

проведите диагностику состояния системы, в том числе проверку фотодатчика и датчика скорости 

конвейера. 

 

Тест чувствительности фотоэлемента 
 

Данный тест проверяет корректность настроек фотоэлемента для конкретной задачи. 

 

 

ПРИМЕЧАНИЕ: Тест следует проводить с образцом настоящего изделия. 

 

 

1. Поместите тестовый образец перед фотодатчиком на расстоянии около ¼ дюйма (0.6 мм); 

фотодатчик должен обнаружить объект. 

2. Поместите тестовый образец в середине направляющих полозьев; фотодатчик должен обнаружить 

объект. 

3. Поместите тестовый образец на одно из направляющих пользьев; фотодатчик не должен 

обнаружить объект. 

4. Проверьте, что объекты на дальней стороне конвейера не вызывают срабатывание фотодатчика. 

5. Убедитесь, что цветовые различия разновидностей изделий не вызывают множественные 

срабатывания фотодатчика на больших расстояниях. 

 

 

ПРИМЕЧАНИЕ: Если красный светодиод на фотодатчике не загорается когда объет 

помещается перед ним (но не касается его), это означает, что фотодатчик отключен, либо 

фотодатчик не работает, либо на него не подается напряжение питания. 
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Решение проблем с качеством печати 
 

В данном разделе приведены примеры некоторых проблем с качеством печати и действий, которые 

нужно предпринять для их устранения. 

 

Проблема: Тонкие полосы в каналах печати. 

Возможная причина: Загрязнение передней панели, воздух в канале. 

Действия: Выполните цикл Автоматическая система очистки сопел. Чтобы минимизировать 

загрязнения, пользуйтесь кисточками и потоком сжатого воздуха. 

 

 
 

Проблема: Не работают целые каналы в каналах печати. 

Возможная причина: Сильное загрязнение передней панели, воздух в канале. 

Действия: Протрите переднюю панель и выполните цикл Автоматическая система очистки сопел. 

Чтобы минимизировать загрязнения, пользуйтесь кисточками и потоком сжатого воздуха. 

 

 
 

Проблема: Не работают целые каналы печати. 

Возможная причина: Воздух в канале. 

Действия: Выполните цикл Автоматическая система очистки сопел. Если воздух удалить не удается, 

выполните цикл заправки согласно процедуре, описанной в Разделе 4: Установка. 
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Проблема: Не работают нижние каналы печати. 

Возможная причина: Скопление чернил в нижних соплах. 

Действия: Протрите переднюю панель и выполните цикл Автоматическая система очистки сопел. 

 

 
 

Проблема: Размазанная печать. 

Возможная причина: Печатающая головка находится слишком далеко от поверхности изделия. 

Действия: Поместите печатающую головку на расстояние 1/8 дюйма (0.3 мм) от изделия. 

 

 
 

Проблема: «Шахматные доски» на месте штрихкода. 

Возможная причина: Проскальзывание датчика скорости или тряска приводного ремня. 

Действия: Затяните крепления датчика скорости, замените уплотнительные кольца датчика при 

необходимости или замените приводной ремень конвейера ровным бесшовным приводным ремнем. 
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Проблема: Шаблон вытянут, на месте штрихкода «шашечные доски». 

Возможная причина: Используется неподходящий датчик или установлена некорректная скорость 

конвейера (слишком маленькая) с внутренним датчиком. 

Действия: Проверьте, что используется верный датчик (5000 PPR). 

 

 
 

Проблема: Узкое изображение, темная печать, на месте штрихкода «шашечные доски». 

Возможная причина: Используется неподходящий датчик или колесико неверного размера или 

установлена некорректная скорость конвейера (слишком маленькая) с внутренним датчиком. 

Действия: Проверьте, что используется верный датчик (5000 PPR). 
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Приложение A: Спецификации 

 

Спецификации контроллера 

 
 

Процессор:     Intel® Atom™ N270 

Напряжение питания:    100-240 В переменного тока, 50-60 Гц, макс. 3А 

Порты:     COM1, COM2 – последовательные порты RS232 

10/100/1000 Мбит/с – Base-T Ethernet 

2 или 4 порта печатающих головок 

2 или 4 порта датчика 

Сигнальный светодиод, трехцветный 

Видеовыход VGA 

Порты USB 2.0,1 внешний и 2 внутренний 

DVI-D 

Звук 

Оперативная память:    2 Гб, 200-контактная DDR2 SO-DIMM 

Жесткий диск:    Твердотельный SATA емкостью 40 Гб 

Сигнализация:    Дополнительный трехцветный светодиод 

Корпус:     Нержавеющая сталь 

Вес:      26.5 фунтов (12.0 кг) (контроллер) 

Операционная система:  Windows® XP Professional 

Монитор:     ЖК-монитор с диагональю 17 дюймов и разрешением 1280x1024 

с сенсорным экраном 

Клавиатура     Программная 

Условия окружающей среды:   Температура окружающей среды : от 40° до 104° F (5° – 40° C) 

Влажность: 10-90%, без образования конденсатаа 

Типы печатающих головок:  ProSeries 768 и ProSeries 384 

Максимальное расстояние  

от печатающей головки  

до контроллера:    25 футов (7.6 м) 

заклепки 
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Спецификации печатающих головок 
 

Печатающая головка 384: 

 

 
 

Печатающая головка 768: 

 

 
 

 

 

(С ОБЕИХ СТОРОН) 

(С ОБЕИХ СТОРОН) 

(ГЛУБИНА) 

(ГЛУБИНА) 
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Электрические подключения:  Стандартный кабель длиной 30 дюймов (0.76 м) 

Дополнительный кабель длиной  25 футов (7.5 м) 

 

Ориентация печати:  Встроенная – Горизонтальная или под углом к горизонтальной 

(для наклонной печати) 

 

Система подачи чернил:   Капиллярная технология заправки без давления 

 

Заправка:  Система автоматической заправки (недоступна в печатающих 

головках Alpha-Coder) 

 

Плавающий датчик:  Определение низкого уровня чернил и переполнения емкости 

для сбора отходов (переполнение емкости для сбора отходов не 

определяется в печатающих головках Alpha-Coder) 

 

Спецификации чернил:  ScanTrue II® (печатающие головки 384 и 768), 

пигментированные, на масляной основе, для пористых 

поверхностей  

 

Технические данные: 

 Головка 384 Головка 768 

Область печати: 0.38 – 2 дюйма (10 – 51 мм) 0.38 – 4 дюйма (10 – 102 мм) 

Каналов: 128 256 

Количество сопл: 384 768 

Горизонтальное разрешение: 150 или 300 dpi 150 или 300 dpi 

Строк печати: 1 – 21 1 – 42  

 

Условия работы:    Температура: 50° - 104° F (10° - 40° C) 

Относительная влажность: 20 - 80% (без образования 

конденсата) 

 

Условия хранения:    Температура: 32° - 109°F (0° - 43° C) 

Относительная влажность: 20 - 80% (без образования 

конденсата) 
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Приложение B: Теоретические сведения о работе системы 

 

The Marksman© Elite 
 

Marksman© Elite – контроллер струйного принтера высокого разрешения, используемый для печати 

информации на картонных коробках, перемещающихся на конвейере перед печатающими головками. 

Это промышленный контроллер на базе персонального компьютера, в котором для создания и работы 

с изображениями, которые нужно напечатать, используется одноплатный компьютер под 

управлением Windows XP®. На плате расположены все периферийные устройства компьютера, такие 

как видеокарта и сетевая карта Ethernet. В дополнение к одноплатному компьютеру в системе также 

есть контроллеры печатающих головок. Они отвечают за преобразование данных, поступающих от 

одноплатного компьютера, в формат, который понятен печатающим головкам, и передают 

информацию о состоянии печатающих головок одноплатному компьютеру. Когда данные готовы для 

отправки печатающей головке, они передаются ей по кабелю DB25. 

 

Для ввода сообщений используется встроенная клавиатура и сенсорный экран, а для их хранения – 

жесткий диск, с которого при выборе задания считывается необходимая информация. В системе два 

различных источника питания. Один формирует напряжение 12 В, необходимое для работы 

логических схем, другой – 24 В, необходимое для работы нагревателей головок и преобразователей 

постоянного тока. 

 
Печатающие головки 
 

Marksman© Elite поддерживает все печатающие головки серии Elite. Печатающая головка состоит из 

резервуара, управляющей электроники и модуля печати. Данные и питающее напряжение передаются 

печатающей головке по кабелю DB25. 

 

В состав управляющей электроники входят универсальная управляющая плата и управляющая плата 

Marksman©. Первая получает 24 В постоянного тока и формирует высокое напряжение, необходимое 

для работы модуля печати. Вторая (только на печатающих головках UJII) преобразует 

последовательные данные контроллера в параллельные данные с высокими уровнями напряжения, 

необходимые для управления каналами модуля печати. 

 

В состав Автоматическая система очистки сопел входят емкость для сбора чернил, вакуумный 

насос, плата Автоматическая система очистки сопел, насос заправки и резервуар. Управляющие 

сигналы цикла Автоматическая система очистки сопел передаются по кабелю DB9 контроллером 

Marksman© Elite. Параметры цикла Автоматическая система очистки сопел устанавливаются 

программно. Важно, чтобы этот кабель был подключен. Питающее напряжение и сигнал «низкий 

уровень чернил» передаются Marksman© Elite по кабелю DB25. В емкости для сбора чернил хранятся 

использованные чернила, поступающие туда в процессе работы циклов Автоматическая система 

очистки сопел. Если емкость заполнена целиком или в резервуаре мало чернил, Автоматическая 

система очистки сопел отключается и загорается светодиод, сигнализирующий об ошибке. 

 
Фотодатчик 
 

Когда изделие проходит перед фотодатчиком, он фиксирует это, и формирует сигнал, запускающий 

процесс печати. Заканчивается печать тогда, когда напечатана вся необходимая информация, 

независимо от сигнала фотодатчика. 
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Датчик скорости 
 

Датчик выдает контроллеру сигнал о необходимости печати следующего столбца изображения. 

Возможно подключение внешнего датчика или использование внутреннего. Внешний датчик 

устанавливается на конвейере и определяет, когда нужно печатать очередной столбец. При изменении 

скорости конвейера изменяется и временной интервал между отдельными столбцами, и датчик 

выполняет необходимую коррекцию. Внутренний датчик использует заданный интервал времени, 

поэтому при изменении скорости конвейера изображение будет сжиматься или растягиваться до тех 

пор, пока скорость конвейера не будет отрегулирована. 

 

Электрическая схема соединения компонентов 
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Приложение C: Компоненты системы 

Расходные материалы 
Номер компонента Описание 

001-0598-01F Чернила ScanTrue II® 

2464620 В комплекте – резервуар для сбора отходов (чернила ScanTrue II®) 

2464621 В комплекте – крышка клапана резервуара 

X30001-001 Ткань для протирания печатающей головки (300 шт./упак.) 

 

Запасные части 
Номер компонента Описание 
2465245 В комплекте – монитор 

2465246 В комплекте – плата управления печатающей головкой 

2465247 В комплекте – плата ЦП 

2465248 В комплекте – жесткий диск Elite 

2465249 В комплекте – источник питания 12 В 

2465250 В комплекте – источник питания 24 В 

2465251 В комплекте – вентилятор Elite 

2465252 В комплекте – оперативная память 2 Гб Elite 

 

Крепления 
Номер компонента Описание 

2465243 В комплекте – T-Stand, Elite 

2465244 В комплекте – крепления конвейера Elite 

2465254 В комплекте – крепления кронштейна Elite 

 

Аксессуары 
Номер компонента Описание 

2465253 В комплекте – сигнальный светодиод Elite 

  

 

МОНИТОР 

ЗА КРЫШКОЙ ВНУТРИ КОРПУСА ВНУТРИ КОРПУСА 
ВЕНТИЛЯТОР 

ПЛАТА 

КОНТРОЛЛЕРА 

ПГ 

ЖЕСТКИЙ ДИСК И 

КРЕПЛЕНИЯ 

ПЛАТА ЦП ИСТОЧНИК 

ПИТАНИЯ 24 В 

ИСТОЧНИК 

ПИТАНИЯ 12 В 
ВЕНТИЛЯТОР 



www.foxjet.ru     +7 (495) 984-0-489 Страница 105 
 

Компоненты для обслуживания системы печати 

 
 

НОМЕР НОМЕР 

КОМПОНЕНТА 

ОПИСАНИЕ 

1 2464632 Печатающая головка, 384, ScanTrue II, АСОС 

2464613 Печатающая головка, 768, ScanTrue II, АСОС 

2 2464625 Насос для заправки, ScanTrue II 

3 и 8  2464616 Трубки резервуара для сбора отходов и системы подачи чернил, 

ScanTrue II 

4 2464617 Плата Автоматической системы очистки сопел 

5 2464618 Выделитель чернил 

6 2464620 Резервуар для сбора отходов, чернила ScanTrue II 

7 2464621 Крышка клапана резервуара 

9 2464623 Плата управления Marksman 

10 2464624 Универсальная плата управления 

11 2464120 Кабель для обмена данными 

12 2464144 Кабель «Плата управления – плата Автоматическая система 

очистки сопел» 

13 5760527 Кабель «Резервуар – плата Автоматическая система очистки 

сопел» 

14 2464146 Кабель «Основной насос – плата Автоматическая система 

очистки сопел» 

15 2464147 Кабель «Вакуумный насос – плата Автоматическая система 

очистки сопел» 

16 2464629 Плата HV, только для головок 384 и 768 Heads (не показана) 
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Приложение D: Проверка электрических розеток 
 

 

ВНИМАНИЕ: Розетка должна находиться недалеко от оборудования и быть легко 

доступной. 

 

 

При использовании стандартной электрической розетки выполните следующую процедуру для 

проверки электрической розетки. 

 

1. Вставьте пробник электрических розеток в розетку. (Его можно приобрести в большинстве 

магазинов, продающих электрооборудование). 

2. Если пробник показывает, что фазы выведены правильно, продолжите установку системы. 

3. Если пробник показывает, что фазы выведены неправильно, незамедлительно сообщите в 

соответствующие службы и не пользуйтесь розеткой до тех пор, пока фазы не будут выведены 

правильно. 

 
Помехи в сети электрического тока 
 

Помехи в электрической сети могут быть в форме пиков или резких спадов, повышения или 

понижения напряжения или шума, вызванного плохим заземлением или внешним воздействием. О 

проблемах с питанием могут свидетельствовать необъяснимая потеря памяти контроллера (потеря 

сообщений), искажение печати и необъяснимые сбросы оборудования. 

 

Лучший способ избавиться от подобных проблем – подключить контроллер к выделенной линии со 

стабилизатором напряжения. Выделенная линия – это линия переменного тока, к которой 

подключены только компоненты системы. Это особенно эффективно, когда линия отводится от 

главной электрической линии здания. 

 

Высококачественные стабилизаторы напряжения избавят вас от всех проблем за исключением 

перебоев электричества, если перебои имеют место в процессе установки, воспользуйтесь источником 

бесперебойного питания (ИБП). 
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Приложение E: Запуск базы данных 

 

Описание 
 

В предыдущих версиях BoxWriter можно было запустить задание с компонентами базы данных, 

которые затем запрашивали у пользователя значение ключа для поиска информации в базе данных и 

замены данных добавленного компонента по умолчанию данными, извлеченными из удаленного 

источника данных. В дополнение к этим возможностям в настоящей версии воможно запросить 

значение ключа, получить это значение, произвести поиск по этому значению в базе данных, найти 

поле задания в базе данных, воспользоваться этим значением для запуска соответствующего задания 

и в процессе запуска задания воспользоваться ранее введенным значением ключевого поля в качестве 

значения для всех полей в базе данных. Таким образом, для запуска верной задачи и получения и 

получения всех данных этой задачи пользователю нужно ввести всего одно значение. Это называется 

«запуском базы данных». 

 
Алгоритм запуска базы данных 
 

Далее приведен краткий алгоритм нового процесса: 

 

1. Оператор инициирует процедуру запуска задания базы данных. Для этого можно выбрать пункт 

меню Operate > Database Start (Работа с программой > Запуск базы данных). В дополнение к этому 

оператор может воспользоваться новой кнопкой "воспроизведение" на панели инструментов, 

помеченной желтым цилиндром. Наконец, для переносных сканеров и/или удаленных систем 

доступен новый параметр Database Task Start. 

 

2. Система ответит на это действие, запросив у пользователя значение ключевого поля. 

 

3. Программа обратится к заранее заданному источнику записей чтобы найти ключевое поле по 

значению, введенному на этапе 2. 

 

4. После обнаружения этой записи программа извлечет ее. В заданном поле с именем задания система 

найдет имя задания, которое нужно запустить. 

 

5. Затем программа запустит это задание и все компоненты базы данных, связанные с этой записью 

(как на этапе 4); система не будет запрашивать пользователя, а воспользуется данными этой записи 

автоматически. Теперь система готова к печати, если не требуется ввода других полей, 

запрашиваемых у пользователя (см. этап 6). 

 

6. Если нужно запросить у пользователя значения других компонентов (например, компонентов базы 

данных, использующих другую запись, или стандартных компонентов, запрашивающих ввод 

пользователя), система запросит значения этих компонентов. 
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Определение запроса к базе данных – Глобальные настройки 
 

Чтобы приложение Marksman Elite смогло обратиться к 

внешней базе данных за именем задания, сначала нужно 

задать расположение базы данных. Для этого нужно выбрать 

пункт меню Configure, Database (Настройка > База данных). 

 

Сначала нажмите на кнопку Select (Выбор) для выбора 

используемого источника данных. 

 

Ниже будет показан список таблиц (или листов) для данного 

источника данных. Выберите в нем необходимую таблицу. 

 

Далее выберите поле, которое будет использоваться в качестве ключевого (Key field) – чтобы задать 

запись, в которой будет найдено имя задания. 

 

Наконец, выберите поле, в котором находится имя задания (Task field). 

 

Ниже показан пример таблицы (на основе приведенных выше данных). (Таблица «TYCO» содержится 

в базе данных Access с именем TYCO в источнике данных «TYCO»): 
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Запуск задания базы данных 
 

После выбора пункта меню Operate > Database Start (Работа с 

программой > Запуск базы данных) или нажатия кнопки на 

панели инструментов (справа от кнопки обычного запуска 

задания) появится окно запуска задания базы данных. 

 

В нем можно либо ввести ключевое поле с клавиатуры, либо 

нажать кнопку Select (Выбрать) для его выбора из базы данных. 

 

При нажатии кнопки OK запускается алгоритм запуска базы 

данных, описанный ранее в этом разделе. 

 
Изменение последовательного порта 
 

Наряду с появлением нового пункта меню и новой кнопки на 

панели инструментов были изменены настройки последовательного 

порта. Окно с измененными настройками приведено на рисунке 

справа. 

 

При выборе запуска задания из базы данных система будет 

получать последовательные данные через порт обмена данными и 

будет использовать эту информацию в качестве значения ключевого 

поля, выбранного в окне «Запуск задания» на предыдущем рисунке. 
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Изменение отчета принтера 
 

Чтобы определить какое ключевое поле было выбрано оператором, в отчет принтера было добавлено 

выбранное ключевое поле. Ключевое поле будет указано в предыдущей строке в поле Task Name (Имя 

задания). 
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Приложение F: Портативный сканер 

 

Настройки быстрого запуска задания 
 

Первый шаг в настройке портативного сканера – выбор цифр штрихкода, которые будут 

использованы для выбора запускаемого задания. Следующий пример демонстрирует этот процесс 

путем использования пяти цифр 12-разрядного штрихкода UPC. Если вы планируете использовать 

этот пример, распечатайте страницу. 

 

Создание задания 
 

Задание, которое будет напечатано после сканирования штирхкода, должно быть связано с этим 

штрихкодом. Для этого нужно создать задание и дать ему имя в виде 5 цифр штрихкода, 

используемого для запуска задания. В примере ниже сканируемый штрихкод таков: 

0 79068 17001 7 
 

Часть штрихкода, которая будет использована для запуска задания, выделена жирным: 17001. Такое 

название нужно дать заданию, т.е. нужно создать задание с названием «17001». 
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Сканер 
 

Подключите сканер либо к дополнительному входному порту (*), либо к порту COM 1. 

 

Задайте настройки сканера для выбранного порта: 

 

Com1: Configure/System/General Settings/Com1/Properties 

(Настройки > Системные > Общие настройки > Сom1 > 

Свойства) 

 

* ПРИМЕЧАНИЕ: На контакт 1 дополнительного входного 

порта подается напряжение +12В, используемое для питания 

сканера Foxjet. 

 

Задайте настройки последовательного порта: 

 Скорость (Baud) = 9600 

 Четность (Parity) = NONE 

 Биты данных (Data Bits) = 8 

 Стоповые биты (Stop Bits) = 1 

 Тип устройства (Device Type) = Task start 

 Использование линии (Line usage) = N/A 

 

Настройки порта для получения имени задания по последовательному порту заданы. 
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Выделение имени задания из строки последовательных данных: 
 

Чтобы создать маску для выделения названия задания из штрихкода, 

откройте свойства конвейера: Configure/Production Line (Настройка > 

Конвейер). Откройте свойства печатающей головки. 

 

Смещение буфера (Buffer offset): Число символов в строке до начала 

имени задания, начиная с 0. В нашем примере смещение равно 6. 

Символы штрихкода: 0 7 9 0 6 8 1 

Смещение буфера:      0 1 3 2 4 5 6. 

 

Длина данных (Data length): Число символов в имени задания. 

17001= 5 символов 

 

Проверка запуска задания 
 

Теперь контроллер должен быть настроен на запуск задания с портативного сканера. Убедитесь, что 

нет выполняющихся заданий, если они есть, воспользуйтесь кнопкой Stop (Остановить). 

 

С помощью портативного сканера считайте штрихкод, с которого было создано задание. Если задание 

запускается, настройки контроллера заданы верно. При необходимости аналогичным образом можно 

добавить дополнительные задания. 

 

Если задание не запускается: 

 Проверьте, что сканер настроен на штрихкоды типа UPC и что в нем есть возврат каретки. 

 Проверьте, что сканер подключен к нужному порту и правильно настроен. 

 Если появилось сообщение «Не удается запустить задание» (Task Failed To Start), убедитесь, 

что название задания задано верно и оно соответствует штрихкоду. 

 

Для помощи в поиске и устранении ошибок можно воспользоваться окном «Диагностика» (View > 

Diagnostic Dialog – Просмотр > Окно диагностики). 
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Приложение G: Шрифты 

 

Список шрифтов 
 

В дополнение к стандартным шрифтам TrueType специально для Marksman© Elite были разработаны 

следующие шрифты. (Свяжитесь с дистрибьютором для получения специальных шрифтов, 

специальных символов или новых шрифтов.) 

 

MK Aardvark 

MK Arabia 

MK Arial 

MK Arial Low Caps 

MK Avalon 

MK Barcode 

MK Courier 

MK Courier Low Caps 

MK Diploma 

MK Fujiyama 

MK Gothic 

MK Harquil 

MK Harquil Low Caps 

MK Script 

MK Times 

MK Times Low Caps 
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Образцы шрифтов 
 

Следующие образцы были напечатаны головкой ProSeries 768 с разрешением 300 dpi (стандартное) и 

шириной по умолчанию. Первые два шрифта (Aardvark и Arabia) показаны в размерах 128, 64 и 32. 

Остальные показаны только в размере 64, но другие размеры для них тоже доступны. 
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Приложение H: Стандартные технологические процедуры 

 

FJSOP1 – Снятие печатающих головок высокого разрешения FoxJet 
 

НАЗНАЧЕНИЕ: Подробно описать процедуру снятия печатающих головок высокого разрешения 

Foxjet с конвейера. 

 

ОТВЕТСТВЕННОЕ ЛИЦО: Клиент или технический специалист авторизованного дистрибьютора 

FoxJet Distributor. 

 

МЕРЫ ПРЕДОСТОРОЖНОСТИ: Все лица, выполняющие эту процедуру, должны пользоваться 

подходящими средствами защиты глаз и перчатками из латекса. 

 

ЧАСТОТА ВЫПОЛНЕНИЯ: Каждый раз при снятии печатающей головки с конвейера. 

 

ПРОЦЕДУРА: 

 

1. Инициируйте процедуру выключения контроллера, 

ВЫКЛЮЧИТЕ И ОТСОЕДИНИТЕ КОНТРОЛЛЕР от 

источника электрического тока чтобы исключить 

возможные проблемы и/или опасность поражения 

электрическим током. 

 

2. Отсоедините все кабели печатающих головок от 

контроллера. 

 

3. Снимите резервуар с чернилами и установите 

предохранительную крышку резервуара. 

 

4. Снимите фильтр клапана резервуара (если есть) и 

закройте резервуар. 

 

5. В системах с поддержкой Автоматическая система очистки сопел снимите емкость для сбора 

отходов и переустановите маленькую черную защитную емкость, которая поставлялась в комплекте. 

 

 6. Установите крышку передней панели на переднюю 

поверхность печатающей головки (при правильной 

установке она должна накрывать каналы). 

 

7. Убедитесь, что все крышки печатающих головок 

установлены и закреплены правильно. 

ПРЕДОХР. КР. 

РЕЗЕРВУАРА 

КРЫШКА 

КЛАПАНА 

РЕЗЕРВУАРА 
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8. Снимите все фотоэлементы и крепления фотоэлементов с печатающих головок, если они есть. 

 

9. Снимите винты, крепящие печатающую головку к креплениям. 

 

10. Оберните переднюю поверхность печатающей головки чистой тканью, чтобы на нее стекли любые 

чернила, которые могут вытечь, и закрепите ткань скотчем или упаковочной лентой. 

 

11. Поместите печатающую головку в пластиковый пакет и закрепите его лентой. 

 

 
 

12. Если предполагается дальнейшее хранение печатающей головки, ее нужно хранить в сухом 

прохладном месте. 

 

13. Если предполагается транспортировка печатающей головки, ее нужно поместить в пенопласт и 

упаковать в оригинальную коробку, в которой она поставлялась. 

 
 

 

ВНИМАНИЕ:  

 

Соблюдение этой процедуры имеет критическое значение для гарантии того, чтобы во 

время транспортировки печатающая головка не получила повреждений. 

 

FoxJet заменит и возьмет плату за любые отсутствующие компоненты перед возвратом. 

 

FoxJet может отказаться от гарантии, если принтер или его компонент вышел из строя в 

результате неправильного использования, небрежности, неправильного обслуживания, 

неправильной поставки или неавторизованных изменений. См. Главную Гарантию. 

 

 

КОНЕЦ 



www.foxjet.ru     +7 (495) 984-0-489 Страница 122 
 

 

FJSOP2 – Ежедневное обслуживание печатающих головок с поддержкой 

Автоматическая система очистки сопел 
 

ОБЛАСТЬ ДЕЙСТВИЯ: Все печатающие головки с поддержкой Автоматическая система очистки 

сопел (Системы автоматической заправки). 

 

НАЗНАЧЕНИЕ: Описать процедуру необходимого обслуживания печатающих головок высокого 

разрешения Foxjet с поддержкой Автоматическая система очистки сопел. 

 

ОТВЕТСТВЕННОЕ ЛИЦО: Клиент. 

 

МЕРЫ ПРЕДОСТОРОЖНОСТИ: Все лица, выполняющие эту процедуру, должны пользоваться 

подходящими средствами защиты глаз и перчатками из латекса. 

 

ЧАСТОТА ВЫПОЛНЕНИЯ: Процедура должна выполняться ежедневно или по мере 

необходимости исходя из качества печати. 

 

ПРОЦЕДУРА: 

 

1. С помощью неворсистой ткани «Texwipe» бережно сотрите пыль, клей и/или другие загрязнения с 

поверхности каналов. Совершайте движения тканью в одном направлении, НЕ ВВЕРХ-ВНИЗ ИЛИ 

ВЛЕВО-ВПРАВО чтобы уменьшить вероятность попадания посторонних частиц в каналы. Движение 

ткани в неверном направлении может привести к повреждению каналов. 

 

2. Нажмите и отпустите кнопку заправки чтобы запустить цикл автоматической заправки (убедитесь, 

что чернила были удалены из каналов с помощью насосов). 

 

3. При необходимости протрите поверхность печатающей головки неворсистой тканью «Texwipe» 

чтобы удалить излишек чернил. 

 

4. Убедитесь, что винты надежно затянуты и все крышки находятся на своих местах. 

 

5. Убедитесь, что когда изделие проходит под печатающей головкой, рабочая поверхность 

печатающей головки параллельна поверхности изделия и находится от нее на расстоянии не более 6 

мм (0.25 дюйма). 

 

6. Убедитесь, что направляющие конвейера отрегулированы таким образом, чтобы избежать контакта 

поверхности изделия с печатающей головкой. 

 

7. Выполните тестовую печать, чтобы убедиться, что все каналы работают и обеспечивают хорошее 

качество печати. 

 

ЕСЛИ КАЧЕСТВО ПЕЧАТИ ПРИЕМЛЕМОЕ, ПРОЦЕДУРА НА ЭТОМ ЗАВЕРШЕНА. 

 

8. Если некоторые каналы не печатают, возьмите несколько неворсистых салфеток «Texwipe» и 

приложите их к рабочей поверхности печатающей головки, чтобы собрать чернила, которые могут 

выделиться на следующем этапе процедуры. 

 

9. Нажмите и удерживайте кнопку продува чтобы заправить систему или выдуть воздух из 

печатающей головки. 
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10. Нанесите жидкость, указанную ниже, на сухую ткань для протирки или свернутую ткань 

«Texwipe». 

 

10.1 Для печатающих головок с чернилами VersaPrint воспользуйтесь спреем FoxJet P/N X31003-001. 

10.2 Для печатающих головок с чернилами ScanTrue II воспользуйтесь спреем FoxJet P/N X31027-001. 

 

11. Проведите тканью по поверхности печатающий головки чтобы удалить все излишки чернил и 

спрея. 

 

12. Выполните тестовую печать, чтобы убедиться, что все каналы работают и обеспечивают хорошее 

качество печати. 

 

ЕСЛИ КАЧЕСТВО ПЕЧАТИ ПРИЕМЛЕМОЕ, ПРОЦЕДУРА НА ЭТОМ ЗАВЕРШЕНА. 

 

13. Если некоторые каналы не печатают, повторите шаги с 8 по 12. 

 

Замена резервуара для сбора отходов в Автоматическая система очистки сопел 

 

В системах автоматической заправки FoxJet APS резервуары для сбора отходов устанавливаются на 

задней поверхности печатающей головки/системы подачи чернил и позволяют цепи обнаружения 

чернил отключить Автоматическая система очистки сопел когда резервуар наполняется полностью. 

Если не заменить заполненный резервуар для сбора отходов, система автоматической заправки 

работать не будет. 

 

Чтобы максимизировать срок службы оборудования и увеличить производительность, необходимо 

проводить предварительные ежедневные, еженедельные и/или ежемесячные процедуры 

обслуживания. 

 

Если эти процедуры не выполняются регулярно, их следует незамедлительно сделать главным 

приоритетом в продлении срока службы системы. 

 

FoxJet может отказаться от гарантии, если принтер или его компонент вышел из строя в результате 

неправильного использования, небрежности, неправильного обслуживания, неправильной поставки 

или неавторизованных изменений. См. Главную Гарантию. 

 

КОНЕЦ 
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FJSOP3 – Ежедневное обслуживание печатающих головок без поддержки 

Автоматическая система очистки сопел 
 

ОБЛАСТЬ ДЕЙСТВИЯ: Все печатающие головки без поддержки Автоматическая система очистки 

сопел (Системы автоматической заправки). 

 

НАЗНАЧЕНИЕ: Описать процедуру необходимого обслуживания печатающих головок высокого 

разрешения Foxjet без поддержки Автоматическая система очистки сопел. 

 

ОТВЕТСТВЕННОЕ ЛИЦО: Клиент. 

 

МЕРЫ ПРЕДОСТОРОЖНОСТИ: Все лица, выполняющие эту процедуру, должны пользоваться 

подходящими средствами защиты глаз и перчатками из латекса. 

 

ЧАСТОТА ВЫПОЛНЕНИЯ: Процедура должна выполняться ежедневно или по мере 

необходимости исходя из качества печати. 

 

ПРОЦЕДУРА: 

 

1. С помощью неворсистой ткани «Texwipe» бережно сотрите пыль, клей и/или другие загрязнения с 

поверхности каналов. Совершайте движения тканью в одном направлении, НЕ ВВЕРХ-ВНИЗ ИЛИ 

ВЛЕВО-ВПРАВО чтобы уменьшить вероятность попадания посторонних частиц в каналы. Движение 

ткани в неверном направлении может привести к повреждению каналов. 

 

2. Сверните две салфетки «Texwipe» и приложите их к рабочей поверхности печатающей головки, 

чтобы собрать чернила, которые могут выделиться на следующем этапе процедуры. 

 

3. Нажмите и удерживайте кнопку заправки от трех до четырех секунд, чтобы заправить систему или 

выдуть воздух из печатающей головки. 

 

На рынке представлено два типа головок, не поддерживающих Автоматическая система очистки 

сопел: 

 

A: С механическим насосом заправки и кнопкой для управления им. 

 

B: С грушей для заправки, установленной на задней поверхности корпуса печатающей головки. В 

головках такого типа просто сжимайте грушу. Не перекручивайте и не сдавливайте грушу, это может 

повредить ее или ее внутренний клапан. 

 

4. Проведите тканью по поверхности печатающий головки чтобы удалить все излишки чернил. 

 

5. Убедитесь, что винты надежно затянуты и все крышки находятся на своих местах. 

 

6. Убедитесь, что когда изделие проходит под печатающей головкой, рабочая поверхность 

печатающей головки параллельна поверхности изделия и находится от нее на расстоянии не более 6 

мм (0.25 дюйма). 

 

7. Убедитесь, что направляющие конвейера отрегулированы таким образом, чтобы избежать контакта 

поверхности изделия с печатающей головкой. 
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8. Выполните тестовую печать, чтобы убедиться, что все каналы работают и обеспечивают хорошее 

качество печати. 

 

ЕСЛИ КАЧЕСТВО ПЕЧАТИ ПРИЕМЛЕМОЕ, ПРОЦЕДУРА НА ЭТОМ ЗАВЕРШЕНА. 

 

9. Если некоторые каналы не печатают, возьмите несколько неворсистых салфеток «Texwipe» и 

приложите их к рабочей поверхности печатающей головки, чтобы собрать чернила, которые могут 

выделиться на следующем этапе процедуры. 

 

10. Нажмите и удерживайте кнопку заправки не более пяти секунд, чтобы заправить систему или 

выдуть воздух из печатающей головки. 

 

11. Нанесите жидкость, указанную ниже, на сухую ткань для протирки или свернутую ткань 

«Texwipe». 

 

11.1 Для печатающих головок с чернилами VersaPrint воспользуйтесь спреем FoxJet P/N X31003-001. 

11.2 Для печатающих головок с чернилами ScanTrue II воспользуйтесь спреем FoxJet P/N X31027-001. 

11.3 Для печатающих головок с чернилами AlphaMark воспользуйтесь этиловым спиртом. 

 

12. Проведите тканью по поверхности печатающий головки чтобы удалить все излишки чернил и 

спрея. 

 

13. Выполните тестовую печать, чтобы убедиться, что все каналы работают и обеспечивают хорошее 

качество печати. 

 

ЕСЛИ КАЧЕСТВО ПЕЧАТИ ПРИЕМЛЕМОЕ, ПРОЦЕДУРА НА ЭТОМ ЗАВЕРШЕНА. 

 

14. Если некоторые каналы не печатают, повторите шаги с 8 по 12. 

 

Требования по обслуживанию 
 

Чтобы максимизировать срок службы оборудования и увеличить производительность, необходимо 

проводить предварительные ежедневные, еженедельные и/или ежемесячные процедуры 

обслуживания. 

 

Если эти процедуры не выполняются регулярно, их следует незамедлительно сделать главным 

приоритетом в продлении срока службы системы. 

 

FoxJet может отказаться от гарантии, если принтер или его компонент вышел из строя в результате 

неправильного использования, небрежности, неправильного обслуживания, неправильной поставки 

или неавторизованных изменений. См. Главную Гарантию. 

 

КОНЕЦ 
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FJSOP4 – Установка печатающих головок высокого разрешения FoxJet с 

поддержкой Автоматическая система очистки сопел 
 
НАЗНАЧЕНИЕ: Подробно описать процедуру установки печатающих головок высокого разрешения 

Foxjet на конвейер. 

 

ОТВЕТСТВЕННОЕ ЛИЦО: Клиент или дистрибьютор. 

 

МЕРЫ ПРЕДОСТОРОЖНОСТИ: Все лица, выполняющие эту процедуру, должны пользоваться 

подходящими средствами защиты глаз и перчатками из латекса. 

 

ЧАСТОТА ВЫПОЛНЕНИЯ: Каждый раз при установке печатающей головки на конвейер. 

 

ПРОЦЕДУРА: 

 

 

1. Снимите все упаковочные материалы и сохраните их для будущего использования. 

 

2. Убедитесь, что все крышки печатающих головок надежно установлены, не имеют загрязнений, а 

все винты надежно затянуты. 

 

3. Установите печатающую головку и вставьте винты, которые крепят печатающую головку к 

креплению печатающей головки. 

 

4. Отрегулируйте крепление так, чтобы когда изделие проходит под печатающей головкой, рабочая 

поверхность печатающей головки была параллельна поверхности изделия и находилась от нее на 

расстоянии не более 6 мм (0.25 дюйма).  

 

5. Убедитесь, что направляющие конвейера отрегулированы так, что поверхность изделия НЕ БУДЕТ 

СОПРИКАСАТЬСЯ с печатающей головкой.  

 

6. Снимите предохранительную крышку резервуара и вставьте емкость с чернилами (убедитесь, что 

срок годности чернил не истек). 

 

7. Откройте крышку клапана резервуара и установите чистый фильтр клапана резервуара (компонент 

№ X40119-001). 

 

8. Если емкость для сбора отходов не установлена, установите ее (компонент № X01240-002). 

 

9. Снимите заглушку с рабочей поверхности печатающей головки (Сохраните заглушку и 

предохранительную крышку резервуара до снятия печатающей головки с конвейера). 

 

10. ОТКЛЮЧИТЕ ПИТАНИЕ контроллера. 

 

11. Отсоедините контроллер от источника тока, если это возможно. 

 

12. Подключите кабель печатающей головки к контроллеру. 

 

13. Подсоедините кабель фотодетектора к печатающей головке, если он используется. 
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14. Подключите систему к выделенному источнику электроэнергии. 

 

15. Включите питание печатающей головки и подождите, пока она нагреется, что должно занять от 

пяти до десяти минут (для нагрева печатающих головок Marksman Net или UJII 352/32 может 

потребоваться до 30 минут. На контроллерах Marksman Net и Marksman Elite на прогрев печатающих 

головок ProSeries до рабочей температуры тоже может потребоваться до 30 минут.) 

 

16. Сверните несколько салфеток «Texwipe» и приложите их к рабочей поверхности печатающей 

головки, чтобы собрать чернила, которые могут выделиться на следующем этапе процедуры. 

 

17. Нажмите и удерживайте кнопку продува от трех до четырех секунд чтобы выдуть воздух из 

системы. 

 

18. Нанесите жидкость, указанную ниже, на сухую ткань для протирки или свернутую ткань 

«Texwipe». 

 

18.1 Для печатающих головок с чернилами VersaPrint воспользуйтесь спреем FoxJet P/N X31003-001. 

18.2 Для печатающих головок с чернилами ScanTrue II воспользуйтесь спреем FoxJet P/N X31027-001. 

 

19. Кратковременно нажмите кнопку продува чтобы запустить цикл автоматического 

продува/заправки. 

 

20. Проведите тканью по поверхности печатающий головки чтобы удалить все излишки чернил и 

спрея. 

 

21. Выполните тестовую печать, чтобы убедиться, что все каналы работают и обеспечивают хорошее 

качество печати. 

 

ЕСЛИ КАЧЕСТВО ПЕЧАТИ ПРИЕМЛЕМОЕ, ПРОЦЕДУРА НА ЭТОМ ЗАВЕРШЕНА. 

 

22. Если некоторые каналы не печатают, повторите шаги с 16 по 21. Если печатающая головка не 

использовалась длительное время, на «разогрев» всех каналов может потребоваться 30 минут и 

больше. 

 

КОНЕЦ 

 

 

 

 


